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Getting started

For background you'll want to know what is Gopher?.    The introduction to WSGopherwill get you started 
with this client, and configuring WSGopher will help you get set up. If you are a new Windows user, then 
controlling your Windows environment will be important.

You will want to read the Copyright Information.

WSGopher basics

In WSGopher you will use bookmarks to fetch items from host computers. WSGopher uses dialogs to 
help with certain kinds of tasks; there are some shortcuts that are worth knowing about. Of course it is 
always good to know how to get help.

When you are ready, you will want to learn w hat is Gopher+?

WSGopher windows

Find out about the WSGopher main window, particularly if you are not familiar with multi-window 
applications.

You can fetch Gopher items from a directory window, view text documents in a text window, retrieve 
images and other binary files in a download window, search remote databases with a search window, 
search white pages servers with a    phone book window, fill out forms with an    ask form window, and 
launch telnet sessions from a telnet Information window.

WSGopher tools

You can find text in a window within WSGopher. You can show information for an item.    You can print and 
print preview. You can also save items to disk and copy to the clipboard. You can also change the font.

Miscellaneous

Find out what's changed in WSGopher 1.2! For some troubleshooting help, take a look at understanding 
error messages.
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Introduction to WSGopher

WSGopher is a program for Microsoft Windows 3.1 and WinSock 1.1. WSGopher was designed to be a 
tool for work as well as a program that browses the Internet. The version number for WSGopher 1.1 
reflects the development of this program, and is only coincidentally the same as the current WinSock 
specification.

WSGopher communicates with Gopher information servers; there are thousands of these servers on the 
Internet, offering a variety of information.

WSGopher also supports Gopher+, which adds a number of features to the original Gopher.

WSGopher terms

Like any popular technology, Gopher has a terminology that accompanies it. WSGopher combines 
Gopher with Windows; so, even a Gopher expert will see a few more terms here than they may be used 
to.

A Gopher item is a directory, text document, image, search, etc.; anything you can retrieve or activate in 
Gopher is an item. In WSGopher, each item has it's own specialized window. 

A document is the term sometimes used to describe a Gopher directory or text item. In WSGopher it 
refers to the actual data associated with a Gopher window.

A bookmark is the description of how to retrieve a Gopher item. There is a more detailed description 
available. 

Fetch refers to the process of retrieving a Gopher item. Since it involves the network, it is possible that 
you may see some errors. The term 'fetch' is also the key to understanding the     Toolbar button. 

Graphics within WSGopher like  or 

 are called bitmaps in this document. Some users may be more comfortable with the term icons, so 
'icon' has been added to the help file's Search menu. Everything indexed as 'bitmap' is also indexed as 
'icon', even though that word does not appear in the text.

_________________
See also
What is Gopher?
What is Gopher+?
Features list for WSGopher
What s new in WSGopher 1.1



What is Gopher?

Gopher is a tool for gathering information in a network of computers. Some people use it as a browser, 
others as an essential part of their daily work.

Gopher originated at the University of Minnesota. Sometimes a definition of Gopher includes a reference 
to the furry rodent which is U of M's mascot.

If you've used a computer for a little while, you probably know you have a disk drive in there somewhere, 
and you've heard the term directory. A directory on your computer contains files and other directories.

Gopher directories contain items such as text documents and other directories. You can think of a Gopher 
directory in much the same way as you do a directory on your computer, with a few key differences:

Everything in a Gopher directory is on the network, rather than on your local disk drive;
You'll find a greater variety of items in a Gopher directory than you do on your disk drive.

Let's comment just a bit on the last point. On your disk you'll find directories and files. Sure, there are files 
of many kinds, but they are still just files. With Gopher you also have keyword searches on remote 
databases, log in sessions to other computers, interactive forms to fill out, and a variety of files you can 
download.

_________________
See also
Introduction to WSGopher



Overview of Bookmarks

In real life, a bookmark is something you use to hold your place in a book or other reference material. 
Later, you can go right back to the information you need, when you need it.

Gopher keeps track of information in a similar way. Every item you can get to via Gopher has a bookmark; 
in fact, a Gopher directory is just a set of bookmarks.

The thing the bookmark points to is sometimes called an item or Gopher item.

What's inside a bookmark?

A bookmark contains:

a title
the host the item is stored on
the port (needed by the network software, you usually don't worry about this)
the selector, or the command used to fetch the item
the type

The type matters because it influences how WSGopher fetches the item for you. Text should go into a text 
window; a directory window won't know what to do with it. If you fetch a directory into a text window, it 
won't be very informative (unless you are an ace Gopher troubleshooter).

What can you do with bookmarks?

In WSGopher you can add a bookmark to a collection of stored bookmarks, arranged in categories of 
your own choosing. You can then do many things with these categories of bookmarks, using the 
Bookmark Editor.

Sometimes you will want to tell your friends and coworkers about something you have found via 
WSGopher; one easy way to do this is to copy the bookmark to the Windows clipboard, then paste it into 
a mail message or memo.

You can also look inside a bookmark with the Information window.

_________________
See also
Introduction to WSGopher



Overview of Hosts

A host computer is the term used to describe a computer on the network that is offering some kind of 
service. You can make an analogy between computers and houses like so:

There are lots of houses in the neighborhood, and lots of computers on the network.
At one particular house is a party, and you're invited; specifically, the host says you're welcome.
You know the name of the host, but you'll have to look up his or her address.
Chances are, you'll find the address without difficulty!    Occasionally you may find a host whose 

address you can't look up, or for some reason you can't get to the address (maybe the streets are being 
repaired!)

_________________
See also
Bookmarks
Fetching a Gopher item
Understanding Error Messages



Fetch a new Gopher item

In WSGopher there are several ways to fetch a Gopher item:

1. You can select an item in a directory window, then click the Fetch button, or press the ENTER key.
2. You can use the Fetch Bookmark menu to quickly go to the bookmark of your choice.
3. You can use the Bookmark Editor, and while you are there you can fetch.
4. You can use the New Gopher dialog to enter item information ad hoc, or perhaps paste a bookmark 

or URL from the Windows clipboard that you copied from another application.

If someone suggests that you gopher to a particular server, or if you see something interesting posted to 
Usenet, then the New Gopher dialog is the dialog for you.

Getting Started

The simplest way to use the New Gopher dialog is to enter a hostname and press the ENTER key. For 
example, to go to "gopher.uiuc.edu", you simply press the TAB key to bypass the title field, type 
gopher.uiuc.edu, and press the ENTER key. The port field refers to the numeric TCP/IP port that 
Gopher servers use; the default is 70, and this works for most hosts.

If the announcement you read says to use "dewey.tis.inel.gov 2010"    then you'd put 
"dewey.tis.inel.gov" in the Server Name field as before, press TAB to go to the port field, type 2010 
and press the ENTER key.

A Use for Cut and Paste

Let's say you're reading Usenet and you see an announcement for an interesting new Gopher server that 
looks something like the following:

Name=Gopher Jewels
Type=1
Port=70
Path=1/remote/other-gopher/gopher-jewels
Host=crocus.csv.warwick.ac.uk

This is a fairly common way to represent a bookmark but it is more typing than you should be required to 
do. So, copy the text into the Windows clipboard, then in WSGopher bring up the New Gopher dialog. 
Note the Paste button. Usually it is dimmed, but now it is active. When the New Gopher dialog comes up, 
it looks in the Windows clipboard for text that resembles what we see above. Click on the Paste button, or 
use ALT+P, and the entire bookmark is copied into the dialog; even the item type is correct. Press the 
ENTER key and you're in business.

The dialog is smart enough to separate the bookmark text out from whatever other text may be in the 
Clipboard. You can have text above and below, and to the left of any or all of the fields; also, the fields do 
not have to all be present, or be in the order shown.

To reiterate:

1. In the mail reader/newsreader/etc., copy the bookmark to the Windows clipboard
2. In WSGopher: New Gopher, ALT+P, ENTER

The section on Pasting Bookmarks from the Clipboard gives more information on how the paste function 
distinguishes bookmarks from other text.

Shortcuts



Keys: CTRL+N

_________________
See also
Fetch a Gopher item



Visit your Home Gopher

Many users like to connect to a particular Gopher server when WSGopher starts up. You can also 
reconnect to that server while you are running WSGopher..

Shortcuts

Keys: CTRL+H

_________________
See also
Set your Home Gopher server
Go to the top of the Gopher outline



Fetching a Gopher item

When you fetch a Gopher item, a number of steps are involved. You will usually see something in the 
Status Bar which reflects what is going on; occasionally you may run into an error message. So, a basic 
understanding of what is involved should be helpful.

When WSGopher fetches an item:
1. It resolves the hostname; this means that WSGopher makes a request to your network's Domain 

Name Server (aka DNS) to convert the name of the host that the item is stored on, to an address that 
WSGopher can use.

2. Next, WSGopher tries to connect to the host. Making a connection is kind of like calling someone on 
the phone: first you need the phone number; then you may get a busy signal ("Connection refused"), 
or a pre-recorded message ("Too many connections, try again later"); hopefully, you'll usually get 
through.

3. When the connection gets through, WSGopher sends a request to the Gopher server. The server 
uses this information to identify the item you want.

4. WSGopher then prepares to receive the data. If the item you are fetching is a directory, then the data 
is in the form of bookmarks; if the item is a text document, then the data is lines of text; etc.

5. As WSGopher receives data, it reports progress in the Status Bar, or if you are downloading a binary 
file, in the window. If the size of the file is known, then the percentage complete is also shown.

Some Gopher items require some input before you can fetch an item. The Ask form requires you to 
answer one or more questions. When you are downloading a file, you may need to use the File dialog box 
to fill in a file path.

Several Gopher items are interactive queries. With a search item, for each text string you wish to search 
for, WSGopher creates a separate directory window to hold the results of the search. With a phone book 
item, each time you pose a search request, WSGopher displays the results in the phone book window, 
overwriting the previous results.

_________________
See also
    - what is it?



Fetching a Gopher item as something else

Occasionally you will need to fix bookmark that is incorrect. Let's say your directory shows "greatprg.zip" 

as a text file, that is,   is next to it. When you fetch this file, you see gibberish. Here's what to do about 
it:

1. Highlight the "greatprg.zip " item in the Gopher directory window
2. Select Fetch Item As from the File menu
3. Change the type to DOS Archive, then click the OK button or press ENTER.

_________________
See also
Fetch a Gopher item



Fetch bitmap - what is it?

 This is a picture of a dog fetching a stick. It's another one of Ken Blackney's clever bitmaps.

Hopefully, the location of a Gopher item won't be a fast moving target like a thrown stick!    But, life is an 
adventure, and the network is just one more example.

_________________
See also
Toolbar



Information on a Gopher item

This window shows all the available information on a Gopher item. In addition to the normal stuff like 
hostname, port, item type, etc. the Info dialog will show extended information if the item is Gopher+. This 
information may include the name and address of the administrator of the Gopher server; the extended 
views available for this particular item; a brief abstract; and possibly other data.

The easiest way to dismiss this dialog is to click in the window and press the ESC key, or click the Close 
button.

To see information for the active window, press the   Toolbar button. Note that the information first 
displayed applies to the entire window, not to any item that might be selected in the window. To see the 
info for a particular item, simply click on that item, even if it is already highlighted. The Info window will be 
updated with information about the selected item. To see the bookmark for another window, just select 
that window; the Info dialog is automatically updated

You can resize the window by moving the cursor to the top, bottom, sides or corners; when the cursor 
changes to an arrow shape, drag the edge of the window until it is the size you prefer.

You can minimize the Information window by pressing the   Toolbar button in the upper right corner of 
the window. You can restore the window by double clicking the open book icon.

Shortcuts

Keys: CTRL+I

_________________
See also
Copying bookmarks to the clipboard
Understanding error messages



Save an item to disk

You can copy a Gopher item that you have already fetched to a disk file on your computer by selecting 
Save Item in the File menu. Currently, you can only save a text item to disk.

WSGopher will prompt you for a file name, via the Save As file dialog box. WSGopher fills in the item's 
title, or a portion of it, as the filename. The default extension is "txt". However, you can select any 
directory, filename and extension you like.

To save the item, click the OK button.

To cancel saving the item, click the Cancel button.

_________________
See also
Fetch a Gopher item as something else



Deleting downloaded files created by WSGopher

This dialog shows files you have downloaded in this session. Normally, WSGopher treats these files as 
temporary and deletes them on exit. You can circumvent this in the Download window or with this dialog.

To make a file not be deleted on exit, that is currently slated to be, click on the item in the list. Notice that 
the 'x' in the first column is now gone. Similarly, click on the item again to change this setting.

At the bottom of the dialog you'll notice a status line that contains the number of marked files and their 
total size in bytes. This text is updated whenever you click on an item to mark or unmark it.

The Delete Now button will delete the marked files now, rather than later when WSGopher exits.

_________________
See also
Downloading items



Printing in WSGopher

Use this command to print a document. If the active WSGopher window supports printing, then the Print 
option in the File menu is enabled, along with the   button in the Toolbar. 

The Print command presents a Print dialog box, where you may specify the range of pages to be printed, 
the number of copies, the destination printer, and other printer setup options.

When does WSGopher use the Printer font?

WSGopher tries to accommodate two different preferences in printing. One preference is to print using 
the same font as the window you are printing from. The other is to print using a font you select for the 
printer.

To find out which preference will be followed, go to the Configure/Font and look at the item Use Printer 
Font. If it has a check mark next to it then all printing will use the font you have chosen in the Printer Font 
dialog. Otherwise, a font close to the window font will be used. 

To change this setting, simply select Use Printer Font from the menu. This will add the check mark if it 
wasn't there, or remove it if it was there.

Material printed

If the current window is a Directory window, then the titles in the directory are printed.

If the current window is a Text or Phone book window, and if any of the text or search results are selected, 
then the selected text is printed; otherwise, the entire document or search results are printed.

Controlling output

The Page Setup dialog provides some control over how the printed page will appear. The Print Setup 
dialog also influences factors including orientation (portrait vs. landscape) and which printer the output is 
sent to.

When you print, the Print dialog box appears; you have the option of printing all pages, or a specified 
range. The easiest way to tell which pages you want to print may be to preview first.

Shortcuts

Toolbar:  
Keys: CTRL+P

_________________
See also
Printer font
Use Printer font



Exiting WSGopher

Use this command to end your WSGopher session. You can also use the Close command on the 
application Control menu.

Shortcuts

Mouse: Double-click the application's System menu button.

  
Keys: ALT+F4

_________________
See also
Controlling your Windows environment



Copying to the clipboard

Use this command to copy text onto the clipboard. This command will work slightly different, depending 
on the type of Gopher window you are copying from:

for Directory windows, all directory titles are copied to the clipboard
for Text windows, if you have selected text, then just the selected text is copied; otherwise the 

entire document is copied
for Phone book windows, if you have selected one or more lines from the results window, then 

those lines are copied; otherwise all the results are copied
for the Bookmark Editor, for each bookmark you have selected in the Bookmarks list, the 

"canonical" form of the bookmark is copied to the clipboard.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:   
Keys: CTRL+C

_________________
See also
Copying bookmarks



Copying a bookmark: Step-by-Step Procedure

To copy a bookmark from a Gopher directory:
1. Make the window the active Gopher window.
2. Bring up the Information dialog with the   Toolbar button
3. Optionally select a portion of the text with the mouse; I recommend starting at the top and 
selecting do the line above URL; or select just the URL.
4. Click the Copy button or press CTRL+C

The bookmark is now copied to the Windows clipboard.

To copy a bookmark within the Bookmark Editor:
1. select the item by clicking on it
2. click the button labeled "Copy"

You can copy more than one bookmark at a time using the Bookmark Editor.

_________________
See also
Copying to the clipboard



Finding text

You can search for text within a Gopher item you have already fetched. Select Find Text from the File 
menu, or click the   button in the Toolbar. The Find dialog will appear.

The search starts at your current selection, or the top of the window if you have not selected anything.

To search for text
Enter the text you wish to search for in the field labeled Find What; WSGopher does not support 

word search, so if your text contains spaces or other separators, that is what WSGopher will look for. 
WSGopher does not span lines looking for text.

Click the Match Case toggle if you want to do case sensitive searches; otherwise, case will not 
matter

Choose between Up and Down, depending on which direction you want the search to go

WSGopher will search for your text, and will select the item containing the text. For text windows, 
WSGopher will select the matched text.

If WSGopher gets to the end or beginning without finding the text, it will display a dialog stating "Text not 
found".

Find text settings

WSGopher will "remember" the settings you used to search for text, and restore those when you next 
search for text with the Find dialog, or use Find Text Again.

Boolean text search within WSGopher

WSGopher 1.1 supports a method of text search called Boolean. This means you can use two search 
strings at a time, and apply a little logic to your search.

Let's say you were searching for Steven Brown, but you weren't sure if his name was spelled Steven or 
Stephen. If you had a list of Browns, then the search string

Steven OR Stephen

would match either Steven or Stephen. It's pretty simple. The layout is this:

<search string> <VERB> <search string>

The    < and > are not included, as we saw in our example. WSGopher expects one or more spaces 
between the search string and the verb, both on the left or the right. It removes those spaces, but spaces 
inside the search strings are untouched. That means that

Steven OR Stephen

is the same as

Steven      OR      Stephen

The following table describes the Boolean verbs used by WSGopher.

Verb Meaning
AND Both strings must be found in order to match
OR Either string will cause a match



NOT The first string must be found, but NOT the second
ADJ Both strings must be found; furthermore, the distance between the strings must 

be half or less the length of the entire string

Boolean search in a text document

When you do a Boolean search in a text document, and if WSGopher matches a string, then the text it 
highlights starts at the beginning of the first matched string and ends after the second matched term.

_________________
See also
Finding text again
Searching on the net



Finding text again

Once you have used Find text, you can search again for the same text, in any Gopher window that 
supports text search. Merely activate the window you wish to find text in, then find text. You can search 
for the same text in as many windows as you like.

Typically, you will find text again after you have dismissed the Find text dialog.

If you want to change the text, the direction or case matching, you must use the Find text dialog.

Find text again supports the new Boolean searches.

Shortcuts

Toolbar:
Keys: F3

_________________
See also
Finding text



Adding Bookmarks

You can add the bookmark for the active item in WSGopher, to a bookmark category. The active item is 
one of the following:

If the active window is not a directory window, then the item in the window is the active item
If the active window is a directory window, then the selected item in the directory window is the 

active item

To add a bookmark, use Add Bookmark in the Bookmark menu, or use the   Toolbar button. 

To add a bookmark for a directory window, use Add Directory Bookmark in the Bookmark menu, or use 
the     Toolbar button. 

Which category does it go into?

If you have selected one category to be the default category, then the bookmark will automatically be 
added to that category.

Otherwise, WSGopher brings up the category window; you can select one of the listed categories, or 
create a new category and select that. You can also rename and delete categories while the category 
window is up.

_________________
See also
Categories
Set a default category
Addding directory bookmarks
Getting information on a Gopher item
Pasting bookmarks in the Bookmark Editor



Bookmark Editor

Each Gopher item you see in a directory, or that you retrieve, is described by a bookmark. Like most 
Gopher clients, WSGopher lets you store bookmarks on your hard disk so that you can fetch items of 
interest without navigating through Gopher directories.

WSGopher organizes your bookmarks in named categories. The Bookmark Editor gives you access to all 
the bookmarks in a given category, and lets you switch categories. The Bookmark Editor and the 
Category window work together to let you create, delete and rename categories while you are working 
with your bookmarks. You can also use the Category window independently of the Bookmark Editor.

The Bookmark Editor gives you the following access to your bookmarks:
Shows you the current category and number of bookmarks in the category
Shows titles of all the bookmarks in a scrolling list
You can easily modify a bookmark just by selecting it and making desired changes
You can select one or more bookmarks in the list; you can then copy them to the clipboard, delete 

them, or move them to a new category
You can paste multiple bookmarks from the clipboard. This gives you the ability to share 

bookmark categories easily via electronic mail.
A status line at the bottom of the Bookmark Editor shows you the results of your actions, and 

shows intermediate steps as they take place, in potentially long actions.

To select more than one bookmark

You can do this in one of several ways:

Put the mouse cursor over a bookmark in the list. Press the left mouse button, hold it down, then 
sweep the cursor up or down to select other bookmarks.

Or, select a bookmark, then press and hold the SHIFT key and select another bookmark. The first 
and last bookmarks and all bookmarks in-between are selected.

Finally, to select bookmarks that are not near each other, press and hold the CTRL key and select 
bookmarks as you wish. The CTRL key acts as a toggle; it will selected bookmarks that aren't selected, 
and unselect bookmarks that are already selected.

_________________
See also
Introduction to WSGopher
Overview of Bookmarks
Category Window



Fetching a bookmark

In the Bookmark Editor, you can fetch a bookmark by doing one of the following:
First select the bookmark, then click the Fetch button
Or, double click the bookmark

Note that if you select more than one bookmark, the Fetch button becomes disabled. Future versions of 
WSGopher may support fetching items "en masse".

_________________
See also
Bookmark Editor
Fetching Gopher Items



Modifying a bookmark

You can easily modify a bookmark in the Bookmark Editor with the following steps:
1. Select a bookmark in the list. You can select more than one bookmark, but you will only be able to 

modify the topmost selected bookmark.
2. Edit the fields as appropriate; the fields are between the Categories droplist at the top of the 

Bookmark Editor, and the bookmark list. You can change text, use the Item type droplist to change 
the type, and use the Gopher+ toggle to change that setting.

3. Click on any item in the bookmark list. The changes are now committed to the bookmark. You can 
also click the Fetch button to change, then fetch, a bookmark.

4. Click on the OK button to commit changes to disk.

_________________
See also
Bookmark Editor



Deleting one or more bookmarks

In the Bookmark Editor, you can delete one or more bookmarks from a category at a time:
If you select one bookmark, then click the Delete button, the Bookmark Editor deletes the 

bookmark. Note that the Status line shows you the title of the deleted bookmark.
If you select more than one bookmark, then click the Delete button, the Bookmark Editor first 

confirms your action by popping up a dialog box. If you click OK, the bookmarks will be deleted; if you 
click Cancel, they won't.

_________________
See also
Bookmark Editor
Moving bookmarks to another category



Copying one or more bookmarks to the clipboard

Copying one or more bookmarks to the clipboard is pretty simple.

First, select one or more bookmarks. Then click the Copy button. The status line shows what happened.

Why would you do this?

Good question. If you have one or more bookmarks you wish to share with a colleague via electronic 
mail, or insert into an electronic memo, then this is the way to do it. No typing is ever involved; just use 
the Bookmark Editor and click a few buttons, then in your mail package insert the bookmark text from the 
clipboard.

If you prefer to type, you could do something like this:

"First go to gopher.tc.umn.edu, port 70; then select 'Other Gopher and Information Servers'; then 
select 'All the Gopher Servers in the World'; then search for 'Idaho' until you find 'University of 
Idaho' and go there ...

Bookmarks may not make clear reading, but they're easier to work with.

Sharing Categories

Another reason for copying bookmarks to the clipboard is that, if you have developed a specialized 
category of bookmarks, you can easily share the entire category, or selected portions, with your 
coworkers or fellow researchers. Just copy the bookmarks to the clipboard, paste them into an electronic 
mail message, then mail them to the interested parties.

I have had these categories mailed to me, and this is how I handled it:

1. I received the message in my Eudora mailbox.
2. With the message window as the active window, I went to the Edit menu in Eudora and selected 

Select All. I then pressed CTRL+C to copy to the clipboard.
3. In WSGopher I pressed the   Toolbar button, and created a new category with the Category 

window. 
4. In that category I clicked the Paste button, and all my bookmarks appeared. I clicked the OK 
button to save them, and I was finished.

Note:

When the Bookmark Editor pastes bookmarks from the clipboard, it is robust enough to skip most 
other kinds of text. This has been fairly well exercised, though your results may vary.

If you use a different mailer than Eudora, then the method for copying the message to the 
clipboard may be different than what is shown here.

_________________
See also
Bookmark Editor
Pasting one or more bookmarks from the clipboard



Pasting one or more bookmarks from the clipboard

Pasting bookmarks into a category, using the Bookmark Editor, is probably one of the simplest operations 
in WSGopher. All you need to do is click the Paste button. All the bookmarks in the clipboard will be 
processed, and new bookmarks will be added to the current category. Also, each bookmark is highlighted 
so that you can easily see the new ones.

How paste works

1. We look at the Windows clipboard; if it doesn't contain text, then we do nothing. WSGopher isn't quite 
bright enough to paste a bitmap that looks like a bookmark, for instance.

2. Starting at the beginning of the clipboard, and working our way through, we look for the string 'Host='. 
When we stop finding it, we quit.

3. If we find 'Host=', then we also look for 'Name=', 'Type=', 'Port=', and 'Path='. We can always fill in 
default values for these, but there is no default for 'Host='.

4. Order is not important; the 'Host=' string can be before or after the others, and no particular order is 
assumed.

Let's say that the Windows clipboard contains the following:

{ forwarded from ... }
Here's a copy of a bookmark I just retrieved from Usenet; thought you would 
like it.
>Name=Gopher Jewels
>Type=1
>Port=70
>Path=1/remote/other-gopher/gopher-jewels
>Host=crocus.csv.warwick.ac.uk
That's it. Catch you later.

WSGopher starts at the top of the text, the line that says 'forwarded from ...'. It finds 'Host=', and ignores 
the '>' character. It also finds the rest of the information in this bookmark, since it starts at the top each 
time. After it finds all it can, WSGopher goes past the last field it found and starts looking again. Actually, 
in this example, WSGopher would start at 'crocus' and search forward.

_________________
See also
Bookmark Editor
Copying bookmarks to the clipboard



Moving one or more bookmarks to a different category

It is fairly easy to move bookmarks to another category, in the Bookmark Editor.

1. Select one or more bookmarks from the bookmark list.
2. Click the Move button.
3. The Category window will come up. You can do anything you like to in the Category window, but 

typically you will either select a category from the list, or create a category and select it.

If you select a category and click on OK, then the Bookmark Editor will:
Load the new category
Add the selected bookmarks to it
Save the new category
Delete the bookmarks from the current category
Save the current category

_________________
See also
Bookmark Editor
Category window



Go to the top of the Gopher outline

When you click the   Toolbar button, you will go to the top directory for the active window's bookmark.    
The icon resembles a directory in outline format, the way you may see it in the Windows File Manager; 
the arrow points from an item in the outline to the top item.

What does this mean? 

In the What is Gopher? topic we talk about Gopher directories, how they are on other host computers in 
the network, and how they contain other Gopher items. Gopher is organized this way on purpose; it 
resembles how files and directories are organized on your computer, and most people are at least familiar 
with that.

Let's take the analogy one step farther. Each drive on your computer has a top directory; for instance, the 
C drive has C:\. Gopher is similar in that most, if not all, Gopher servers have a top directory of Gopher 
items.

Why would you want to do this?

If you are Gophering around the network and find an item that interests you, it doesn't make much sense 
to get the top directory for that Gopher server. However, if you have just done a Veronica search and 
found an item of interest, then it may be very attractive to look elsewhere on that server for similar items. 
That is usually the reason that the 'top of the outline feature' has been requested.

_________________
See also
Bookmarks
Host computers
Directories



Category window

WSGopher organizes bookmarks into named categories. The name is one of your own choosing, though 
there is a practical limit to what you can see on your screen.

Each category contains bookmarks; the category could be empty, or potentially it could contain thousands 
of bookmarks. If you like to have large categories, then it's best to have a computer with lots of memory, 
because that's where WSGopher keeps bookmarks when you are working with them in the Bookmark 
Editor.

With the Category window you can:
Create new categories
Rename categories
Delete categories
Set or unset a default category

_________________
See also
Bookmark Editor



Creating categories

To create a new category, enter the new name in the Name field at the top of the Category window, then 
click the Create button. WSGopher searches the already existing categories to make sure that this name 
isn't in use;

if it is, then the Category window puts up a dialog to tell you so
otherwise it creates the category and selects it in the scrolling list

_________________
See also
Categories



Deleting categories

To delete a category, select a category in the list and then click the Delete button. If WSGopher can 
delete the category, then it will remove the category and all the bookmarks in the category from your 
collection, and will remove the category from the list in the Category window.

When can't WSGopher delete a category?

If you are using the Bookmark Editor, then WSGopher will not let you delete the category you are 
currently editing.

_________________
See also
Categories



Renaming categories

To rename an existing category:
1. Select the category in the category list
2. Type a new name in the Name field at the top of the Category window
3. Click the Rename button

There are several things WSGopher checks for when you rename a category:
You must select a category first
The new name can't be one already used by a category
It can't be empty, that is, you must specify a name

What happens when you rename a category you are using in the Bookmark Editor?

WSGopher does the obvious thing; the Bookmark Editor shows you it is now using the new category 
name.

_________________
See also
Categories
Bookmark Editor



Set a default category

At the bottom of the Categories window you will see a droplist. Click the down arrow on the right of the 
droplist, and you will see all the category names. At the top of this list is the text <no default 
category> ; choosing this text means there will be no default.

Choose any other item in the droplist to choose that category as the default. The Categories window will 
also select your choice in the categories list.

What does default category mean?

If you have chosen a default category, then whenever you add a bookmark with the   Toolbar button, or 
bring up the Bookmark Editor with the 
  Toolbar button, WSGopher will use the default category rather than bring up the Category window and 

force you to choose.

If you will be working a lot with one category, this feature will save you some time. 

_________________
See also
Categories
Bookmark Editor



Setting file associations in WSGopher

WSGopher includes a Viewers dialog which enables you to set up file associations, independently of the 
Windows File Manager. Specifically, when you ask WSGopher to view a file you have downloaded, 
WSGopher will use the filename extension (the three characters after the '.' or period) to figure out which 
program on your PC to run.

If you select Viewers from the Configure menu, then use these steps to add file associations:
1. Type an extension in the field labeled File extension

2. Click the   Toolbar button. This will bring up the Browser. Find the correct program, click the OK 
button, then click the Add button in the Viewer dialog. The extension and viewer are added to the list 
of viewers.

3. Repeat as needed, then click the OK button in the Viewers dialog to save your changes.

Note: if you view a file that WSGopher cannot find a viewer for, either in its own configuration or in the 
File Manager, WSGopher will pop up the Viewers dialog and fill in the extension for you. You should 
browse for a viewer as shown above, and click the Add button, then the OK button in the Viewers dialog.

To modify file associations:
1. Select the extension and viewer in the list of viewers
2. Use the   button to find the correct viewer
3. Select any view in the list to save your changes, or click the OK button to save your changes and 
exit the dialog.

_________________
See also
Viewers



Configuring WSGopher

There are several things you should probably set up when you install WSGopher:
Set your Home Gopher Server
Set the directories WSGopher will use
Set up viewers
Set the path and command line parameters for your telnet and 3270 emulator programs
Set convenient fonts for your windows
Set a font for your printer, and whether you wish to use the printer or window font when you print 

with WSGopher
Check the User Options dialog for other setting you may wish to change

At some point, you may also like to check the extended views. You can set the paths for viewers for these 
views, and change the ranking.

_________________
See also
Introduction to WSGopher



Setting your Home Gopher Server

Many Gopher users like to connect to a Gopher server when they start their session. WSGopher supports 
this via the Home Gopher Server dialog. You can enter the hostname and port of your local Gopher 
server. Note that there is a flag specifying whether this server is Gopher+ or not; when in doubt, leave it 
off, as it will hurt nothing. You might wish to contact your Gopher administrator to see if the server 
supports Gopher+, as it gives you some nice, new features.

The title field lets you control what the title for your initial Gopher window contains. It's not provided by the 
server, so we let you put anything you like.

Notice that there are places to enter two Gopher servers. This dates back from the early days of the 
University of Minnesota Gopher server; one machine became so busy that they "cloned" it, and modified 
their client to pick from two servers at random, to lighten the load. This works best of course if the 
machines are configured identically, or very similar. Contact your Gopher administrator to see if this 
applies to you.

Which Home Gopher is right for you?

If your campus or place of work has a Gopher server, that is the obvious choice.
If there is a university or college in your area, contact them to see if they are on the network and if 

they have a Gopher server you could connect to.
Otherwise, go to 'All the Gopher servers in the world' in the 'Gopher Services' category, and find a 

Gopher server somewhere near you.

_________________
See also
What is Gopher+?



Directories on your system that WSGopher uses

WSGopher sometimes needs to create a file on your computer's disk. This happens when you download 
a file, such as a weather map, word processing document, PostScript file, etc.

Note that unless you tell WSGopher to save one of these downloaded files, it will delete the file when you 
exit WSGopher.

WSGopher may occasionally make a temporary file.

You can tell WSGopher which directory to use for downloading files, and which directory to use for 
temporary files. They can be the same directory; WSGopher is very careful about what it deletes.

If you don't tell WSGopher which directories to use, it will use your systems "temp" directory, if the TMP 
environment variable is set; otherwise it will use the directory in which WSGopher is installed.

_________________
See also
Deleting Downloaded Files



Temp directory

In the past, WSGopher created a temporary file for text documents; it no longer does so, but in the future 
it may create temporary files for other reasons.

The convention I have used for filenames is to start them with "goph" followed by digits. Please do not 
delete these files if WSGopher is running. If WSGopher crashes for some reason, these files will be left 
behind; feel free to clean them up if WSGopher is not running.

_________________
See also
Directories WSGopher uses



Download directory

This is the directory where WSGopher will usually put downloaded files.

The User Options dialog contains an option that will cause WSGopher to automatically put files in this 
directory without your prompting.

Otherwise, you will see the File Save dialog whenever you download a file; then you can pick another 
directory if you wish.

_________________
See also
Directories WSGopher uses



Viewers

When you fetch information from the network, sooner or later you will want to see it. If the item is a 
weather image, then a graphic viewer is in order; if the file is a word processing document, then the 
appropriate word processor is the tool of choice.

Unlike some other popular personal computer systems, files in Windows do not contain information on the 
application that generated them. Instead, Windows "associates" an application with the file's extension. 
For example, some common associations are:

Extension Application
WRI Windows Write
GIF Compuserve Graphics Image Format
TXT Text, usually ASCII; any editor should do
DOC Often used by Microsoft Word and other word processors
PS PostScript

Experienced PC users can think of many more such associations.

When you download a file, WSGopher gives you the opportunity to view the file when it is completely 
downloaded. To figure out which viewer to use, WSGopher uses the file extension and the associations.

Using the File Manager set up associations

The "preferred" way to set up these associations is to use the Windows File Manager. This is most 
convenient because you only need to configure once, and many other applications (including WSGopher) 
will take advantage of the information.

You can use these steps to set up an association in the Windows File Manager:
1. Start the File Manager if it is not already running.
2. In the File menu select Associate.
3. Type in the extension you wish to associate a view with. If you have already selected a file, for 

instance a file with extension "GIF", this will be filled in for you.
4. Click the Browse button to search for a program to view the file with. This assumes you already have 

access to such a program, either on your hard disk or network disk.
5. Click the OK button. You are done.

Setting up associations in WSGopher

WSGopher checks its own configuration of associations before checking the Windows File Manager. The 
Viewers dialog is used to add and modify these associations.

_________________
See also
Editing extended views



Terminal emulation

Gopher supports a login type, giving you access to another way of getting information on the Internet. 
The Gopher item includes the host to log in to, an optional port, and optional information you need to log 
in to this host. This information might include a user ID and password.

Typically you will see public access accounts available through Gopher. Sometimes you will see a 
commercial service; you must contact the service provider to get access to that information.

WSGopher supports terminal login sessions by running a WinSock compatible terminal emulation 
program. Prior to running this program, WSGopher puts up a telnet information window containing any 
optional information, or hints, that the Gopher item might include. 

The telnet information window also includes a Start button. Click this button to start the terminal emulator. 
In fact, each time you click this button, WSGopher will run the emulator program.

_________________
See also
Setting the path for your terminal emulator program(s)
Terminal emulation and extended views



Telnet/3270 Paths

In order to run your emulator programs, WSGopher needs to know where they are. You use the 
Telnet/3270 paths dialog to set this information.

What are telnet and 3270?

You may be wondering what telnet and 3270 are, or why WSGopher asks you to configure both of them. 
Telnet is the standard Internet application protocol for remote login; it was originally designed for line or 
character oriented terminals. International Business Machines offers a line of data entry terminals 
commonly called the 3270 family. While they are neither line nor character oriented, they have been 
available for years and are very popular.

Most importantly, both telnet and 3270 are Gopher item types.

How to set the telnet and 3270 paths

Note that both telnet and 3270 have a  button to assist the user in finding and entering the correct path. 
Use the browser, then click on its OK button. The path for the program you selected now appears in the 
text field next to the browser button.

Command line

At this point you need to refer to your emulation program's documentation. Find out what it needs for a 
command line. Ideally, you want to be able to pass both host and port to the emulation program.

If the program supports the "traditional" format of

program-name host port

then you do not need to do anything else. Otherwise, you will need to edit the command line.

_________________
See also
Terminal emulation
Terminal emulation and extended views



Browser  

The Browser is a feature in WSGopher that allows you to quickly find a program. It uses the Windows File 
dialog box to locate an executable file, or an "*.exe" file.

When you click the OK button, the Browser replaces the contents of the edit field associated with the 
browser button, with the file path you selected.

If you click the Cancel button, the Browser does not change the edit field.

_________________
See also
Editing extended views
Telnet/3270 paths
Viewers



Editing the terminal emulator command line

Once you have determined what command line your terminal emulator program requires, you are ready 
to set up WSGopher to use the correct command line.

A simple example

One popular telnet client takes a command line of this form:

<telnet> host:port

where '<telnet>' is the name of the program. Note that a colon comes between the host and port with an 
intervening space.

For example, let's say the path for <telnet> is C:\NET\TELNET\TELNET.EXE. To set up this program in 
WSGopher, you would do the following:

Step: Contents of edit field:
Use the  to get the path for the <telnet> 
program; you could type it in if you wish.

C:\NET\TELNET\TELNET.EXE

Click the Host button. C:\NET\TELNET\TELNET.EXE %host%
Enter a colon immediately after the host 
parameter.

C:\NET\TELNET\TELNET.EXE %host%:

Click the Port button. C:\NET\TELNET\TELNET.EXE %host%: %port%
Click inside the edit field and remove the 
space after the colon.

C:\NET\TELNET\TELNET.EXE %host%:%port%

You are now finished. Click the OK button if you are done entering path information.

A more involved example

Let's say we have purchased the upgraded telnet program. It needs more command line arguments then 
before. For the sake of discussion, we'll use the following command line:

C:\NET\NTELNET\TELNET.EXE -emulate vt100 <host> -port <port>

Being good Internet explorers, we are willing to type things we don't fully understand!    Without echoing 
the intermediate steps like we did above, let's go over how we do this:

1. Use the Browse button to select the correct path.
2. Click in the edit field and type "-emulate vt100". Note the space before the hyphen.
3. Click the Host button.
4. Click in the edit field and type " -port". Again, note the space before the hyphen.
5. Click the Port button. You are now finished.

By using the Host and Port buttons, you will be more confident that you are creating a command line that 
WSGopher will later use the way you want it to.

Extended views

You can edit the paths for the extended views with the following steps:
1. Select an extended view from the droplist
2. Use the browser, host and port buttons as shown above

_________________



See also
Terminal emulation and extended views



Terminal emulation and extended views

Gopher offers extended views, containing much additional information, on the basic Gopher item types. 
The view corresponding to 'telnet' is 'terminal/telnet' and the view corresponding to '3270' is 
'terminal/3270'. WSGopher comes configured with these views.

In the future, more extended views for login sessions may be defined. WSGopher currently looks through 
its configuration of extended views and adds each view starting with 'terminal/' or 'telnet/' to the extended 
view droplist.

_________________
See also
Terminal emulation
Telnet/3270 paths
Editing the terminal emulator command line



Fonts

WSGopher gives you the ability to change the font, and the font size, in many of its windows. You can 
also change the font you use when printing from WSGopher.

WSGopher will remember these settings for future sessions.

To change a font

1. Select Fonts from the Configure menu
2. From the menu, choose the item you wish to change the font for
3. The Windows Font dialog appears. Choose a named font from the font list. Try selecting different 

sizes and attributes. An example of the current font appears in the Font dialog. Click the OK button 
when you are satisfied with the font you have selected, or Cancel to not change the font.

For most items, WSGopher will update all windows of that type with the new font. This means that if you 
have three text windows visible, and if you change the Text window font, that the text windows will now 
show the new font.

When WSGopher changes the font for a window, it does not change the size of the window. However, 
scroll bars may appear or disappear as appropriate.

Hint

A proportional font like Times Roman or Ariel will probably work well with most Gopher items. For tabular 
information (that is, tables or data where tabs are important), you may have better results with a fixed font 
such as Courier or Courier New.

_________________
See also
Directory font
Text font
Phone book font
Ask form font
Printer font
Use Printer font



Directory window font

To change the Directory font, select Directory window from the Configure/Fonts menu.

Hint

The bitmaps in a directory do not shrink or grow; so, even if you use a very small font, you will be limited 
in the number of lines you can see in a directory window. This probably matters most when you are using 
a low resolution monitor.

_________________
See also
Fonts



Text window font

To change the Text font, select Text window from the Configure/Fonts menu.

Hint

You probably have the most flexibility with fonts in the Text window. You might take note of the 'Hint' in the 
Fonts topic regarding fixed and proportional fonts.

_________________
See also
Fonts



Phone book font

To change the Phone book font, select Phone window from the Configure/Fonts menu.

Hint

Since the results list in the Phone book is tabular, you might have best results with a fixed font. See the 
'Hint' in the Fonts topic for more information.

_________________
See also
Fonts



Ask form font

To change the Ask form font, select Ask form from the Configure/Fonts menu.

Hint

The Ask form handles fixed and proportional fonts equally well.

_________________
See also
Fonts



Printer font

To change the Printer font, select Printer font from the Configure/Fonts menu.

You will notice that the Font dialog contains many more options for Printer fonts than for WSGopher 
windows.

The topic Printing in WSGopher has more information on the Printer font and when it is used.

_________________
See also
Use Printer font
Fonts



Use Printer font

To change the "Use Printer font" setting, select Use Printer font from the Configure/Fonts menu.

The topic Printing in WSGopher has more information on how this setting is used.

_________________
See also
Printer font
Fonts



Editing extended views

The Extended Views Editor allows you to add to and modify WSGopher's configuration of extended 
views.

There are several ways to get to the Extended Views Editor:
Select Edit Views from the Configure/Extended Views menu
If you select an extended view that WSGopher does not have in its configuration, WSGopher will 

call the Editor, filling in values the best it can. In this case, you will want to edit as appropriate, add the 
view, then click the OK button.

Adding a view

Chances are you will not be adding views very often. However, if you do, here are the steps you need to 
consider:

1. Enter the view name. Gopher extended views contain upper and lower case. However, WSGopher 
does not consider case to be important. The rationale is that "image/JPEG" and "image/jpeg" are 
really the same.

2. Select the Gopher type from the droplist of item types. If the view is handled internally (for example, 
it's a Gopher menu type), then you are finished. For most types not handled within WSGopher, Image 
is a good default.

3. If the view is handled externally, that is, a file you download and use another program to view, then 
you need to decide on a filename extension. Optionally you can select a viewer. If you set one here, 
WSGopher will use this viewer, or it will use the viewers configured in the Viewers dialog, or the 
Windows File Manager.

4. Click the Add button, and you are done.

Modifying a view

To modify a view, first select the view from the list of views, then change anything you need to change. To 
commit your changes you can either select any view in the list, or click the OK button if you are finished 
with the Extended Views Editor.

View ranking

When you select an item in the view list, the ranking for that view appears in a pushbutton. To change the 
ranking of this and other views, click the button; this will bring up the Ranking dialog. When you are 
finished with the Ranking dialog, you will be back in the Extended Views Editor.

_________________
See also
Extended views
Ranking extended views



Ranking extended views

Why you would rank views

The Extended views topic mentions that WSGopher will 'figure out' for you which view to use when 
fetching an item. How does it do this?    Let's answer by way of example.

A typical Gopher+ directory may offer the following views:
application/gopher+-menu
application/gopher-menu
text/html

Your preference might be to use 'application/gopher+-menu', but if that's not available, you prefer 
'text/html' to 'application/gopher-menu'. So, the question is: do you want to always make this choice, or 
would you like to have WSGopher do it for you?

If you prefer the latter, then you might want a setup like the following:

Choose first application/gopher+-menu
Choose second text/html
Choose third application/gopher-menu

With the Ranking dialog you can do this. The highest entry in the Ranked views list (the left column in the 
dialog) will be chosen first; then the next entry, and so on. 

How WSGopher chooses a view

When WSGopher looks through a set of views to determine which one the user prefers, it uses the 
'ranking' as shown in the Ranking dialog. The view at the top of the left column has the highest 'ranking', 
and the view just below it has the next highest ranking. The view at the bottom of the left column has the 
lowest non-zero rank. All the views in the right column have zero rank.

So, the view the user would pick is the one with the highest ranking.    In a way, the rank is like a weight; 
the view with the greatest weight is chosen.

How to rank views

To assign a ranking to a view, select it in the right column, and use the  button to move it to the left. 
If you first select a view on the left, the newly ranked view will be placed just under it. Otherwise, views 
are placed at the top.

To increase a view's ranking, select it in the left column and use the  button to move it up. Use this 
button as many times as needed.

To decrease a view's ranking, select it in the left column and use the  button to move it down. Use 
this button as many times as needed.

To unrank a view, select it in the left column and use the  button.
 
_________________



See also
Extended views



Language used in extended views

Each extended view has three components: a name, an optional language, and an optional size. The 
language information is constructed from standard codes; unfortunately it is not reasy to read. So, 
WSGopher converts the codes into a more usable form. For instance, instead of seeing "EN_US you will 
see "English (US)".

To do this, it uses a table of language codes and visible names. The Languages dialog in the 
Configure/Extended views menu allows you to add to and edit this table. In our example, EN_US would 
be the language code and English (US) would be the visible name.

To add a language to the table, enter the language code as you see it in the list of extended views 
mentioned above; then add the visible name. Then click the Add button.

If you do not know what language it is, you might check the "Top Level Domains" in the Frequently Asked 
Questions (check the bookmark category 'Internet: information resources'). Look at the hostname for the 
item you are fetching. The characters following the last period in the name refer to the domain

At this writing, you will need the proper version of Windows in order to see the document displayed 
correctly.
_________________
See also
Extended views



User Options

The User Options dialog lets you control how WSGopher 'behaves' in several ways.

If you want WSGopher to pick the highest ranked view on its own, set the option "Automatically 
pick the highest ranked view" to 'On'. Otherwise WSGopher will always present the views to you and let 
you decide.

If your WinSock network software cannot handle a period ('.') at the end of a hostname, you will 
get hostname lookup errors. WSGopher can strip the period from the end of the hostname. Set the option 
"Remove trailing period from hostname" if you need this done.

WSGopher tries very hard to make a useful DOS filename when you download Gopher items to 
disk. Then it prompts you with the Windows File dialog, showing you the filename it came up with. If you 
think WSGopher does a good enough job on its own, without your assistance, set the option "Use the 
generated filename, check for uniqueness".

When WSGopher downloads a file, it gives you the opportunity to 'view' the file when the 
download is complete. If you want WSGopher to automatically view the file without your intervention, set 
"Always view the file when download is complete". One reason you may not want to do this is if you 
download executable files. 

When you fetch bookmarks from the Bookmark Editor, you can direct the Bookmark Editor to do 
one of the following:

1. Stay active; do this if you plan to fetch more than one bookmark at a time.
2. Close; do this if you wish the Bookmark Editor to be out of the way.
3. Minimize; do this if wish to keep the Bookmark Editor around for more work, but not just now.

Some people like the the features of WSGopher but only want to look at one window at a time. 
Turn this option on if that is your taste. MDI is Microsoft's term for Multiple Document Interface; it gives 
you all the document windows inside the WSGopher application window. Don't worry; the windows are 
still there, but they are all maximized, meaning they fill the available room inside the application window.

_________________
See also
Extended views



Window Cascade

Use this command to arrange multiple opened windows in an overlapped fashion.

_________________
See also
Controlling your Windows environment



Window Tile

Use this command to arrange multiple opened windows in a non-overlapped fashion.

_________________
See also
Controlling your Windows environment



Arrange Window Icons

Use this command to arrange the icons for minimized windows at the bottom of the main window. If there 
is an open document window at the bottom of the main window, then some or all of the icons may not be 
visible because they will be underneath this document window.

_________________
See also
Controlling your Windows environment



Toolbar

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in WSGopher, such as Fetch Item. A check mark appears next to the menu item when the 
Toolbar is displayed.

_________________
See also
Overview of Toolbar
Controlling your Windows environment



Overview of Toolbar

  

The Toolbar is displayed across the top of the application window, below the menu bar. The Toolbar 
provides quick mouse access to many tools used in WSGopher.

To hide or display the Toolbar, choose Toolbar from the Window    menu (ALT, W, B).

Click one of the icons below to get more specific help.

Click To
 Bring up the Fetch Bookmark menu

  Add the bookmark defining the current item to your collection of bookmarks; if the 
current window is a directory, then the current item is the selected item
Add the bookmark defining the current directory window to your collection of bookmarks

  Bring up the Bookmark Editor; you may have to choose a category first
Visit your Home Gopher Server

 Go to the top of this Gopher's outline
 Backtrack one level in this Gopher's outline

  Bring up the window which shows information on a Gopher item
  Fetch a Gopher item

Cancel the current transaction
Cancel all transactions

  Find text in a Gopher window
  Search again, using the text you searched for last

  Save the current item, or the current selection, to disk

  Copy the current item, or the current selection, to the Windows clipboard
  Print the current item, or the current selection

  Get WSGopher's version number and copyright information; also the email address to 
send correspondence to

  The context help key, one of the most powerful means of getting help in WSGopher

_________________
See also
Viewing the Toolbar



Status Bar

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed Toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

_________________
See also
Overview of Status Bar



Overview of Status Bar

  

The Status Bar is displayed at the bottom of the WSGopher window. To display or hide the Status Bar, 
use the Status Bar command in the Window menu.

The left area of the Status Bar describes actions of menu items as you use the arrow keys to navigate 
through menus. This area similarly shows messages that describe the actions of Toolbar buttons as you 
depress them, before releasing them. If after viewing the description of the Toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the Toolbar 
button.

The right areas of the Status Bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.

_________________
See also
Viewing the Status Bar



1, 2, 3 ... numbered windows

WSGopher displays a list of currently open document windows at the bottom of the Window menu. A 
check mark appears in front of the document name of the active window. Choose a document from this 
list to make its window active.

_________________
See also
WSGopher Main Window
Controlling your Windows environment



Getting help

One of the more important aspects of using an application is understanding how to get help. In 
WSGopher this is fairly easy; you can use the F1 function key to get help for the current window, menu 
item or dialog, or use SHIFT-F1 and then select something you want help on. This is called context help.

To better understand how to use the Help application itself, try Using Help.

You can get to the main WSGopher Help like this:

If you are using WSGopher, go to the Help menu and select Index
If you are using Help, select the Contents button at the top left, just under the menu bar.

_________________
See also
Help Index
Using Help
Context Help



Help Index

Use this command to display the opening screen of Help. From the opening screen, you can jump to 
step-by-step instructions for using WSGopher and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.

_________________
See also
Getting Help



Using Help

Use this command for instructions about using Help.

_________________
See also
Getting Help



Context Help

  

Use the Context Help command to obtain help on some portion of WSGopher. When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark. Then click 
somewhere in the WSGopher window, such as another Toolbar button, a document window, or a menu 
item. The Help topic will be shown for the item you clicked.

Shortcut

Keys: SHIFT+F1

_________________
See also
Getting Help



Showing WinSock Info

Your WinSock network software returns a set of information to WSGopher when it starts up. This dialog 
displays the information.

To most users, the most useful piece of information is probably the Description. This shows you the 
version of the WinSock software you are using, and the manufacturer's name. Select this text and copy it 
to the clipboard if you need to report problems.

_________________
See also
Understanding error messages



About WSGopher

Use this command to display the copyright notice and version number of your copy of WSGopher.

You will also find an Internet email address. Feel free to send mail to this address with your comments, 
suggestions, and questions.

_________________
See also
Copyright information



Controlling your Windows environment

As a user, you will feel more comfortable operating Windows applications like WSGopher when you feel 
more in control of your environment. This topic will point you to information and shortcuts that should 
prove useful.

For instance:
You should know how to use scroll bars.
There are some general things about Dialogs you should know.
It helps to know how to resize, minimize, maximize and move windows.
Within WSGopher, you can easily move to the next or previous window.
You can close a window, and you can restore a window that you have minimized.
When you know how to get to the Task Switcher, you will definitely save time.

The System Menu

Windows makes available a menu of commands that affect your application window; this is the System 

menu. You can get to this menu by clicking  in the top left corner of the WSGopher main window, or 
any other applications window.

Individual windows in WSGopher

Many of the commands in the System menu are duplicated in a button at the top left corner of the 
individual windows in WSGopher. Many of the procedures for affecting the window are the same; for 
instance, moving a window by dragging the title bar with the mouse works the same for WSGopher and 
its individual windows.

_________________
See also
WSGopher main window



Scroll bars

Scroll bars are displayed at the right and bottom edges of the document window. The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document. You can use the mouse to 
scroll to other parts of the document.

_________________
See also
Controlling your Windows environment



Dialogs

Dialogs differ from other windows in WSGopher in several ways. If you take note of these, they could help 
your work with WSGopher go smoother and faster.

Windows intends that you interact with the dialog, then put it away. This is the case for all but two 
dialogs in WSGopher, the Bookmark Editor and the Information window. You will notice that these 
windows have a minimize button 
 in the upper right corner.

To make dialogs easier, or faster, to use, Windows gives you keyboard shortcuts:

Key Action
TAB Moves keyboard focus to the next field, and selects the text in an edit field
SHIFT-TAB Moves keyboard focus to the previous field, and selects the text in an edit field
ENTER The same as clicking the OK button, or the last button clicked in an editor dialog
ESCAPE The same as clicking the Cancel button
SPACE Toggles a radio button, or 'clicks' a push button
DOWN ARROW If the field is a droplist or combo box, causes the list to drop down

_________________
See also
Controlling your Windows environment



Size command (system menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

  

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move. 
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcuts

Mouse: Drag the size bars at the corners or edges of the window.

_________________
See also
Controlling your Windows environment



Move command (control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.
  

Note:    This command is unavailable if you maximize the window.

_________________
See also
Controlling your Windows environment



Minimize command (control menu)

Use this command to reduce the WSGopher window to an icon. If you minimize an individual window 
within WSGopher, it is reduced to an icon within WSGopher.

Shortcuts

Mouse: Click the minimize icon   on the title bar.

_________________
See also
Controlling your Windows environment



Maximize command (control menu)

Use this command to enlarge the WSGopher window to fill the available space. If you maximize a window 
within WSGopher, it will fill the client area of WSGophers main window.

Shortcuts

Mouse: Click the maximize icon   on the title bar; or double-click the title bar.

_________________
See also
Controlling your Windows environment



Next window

Use this command to switch to the next open document window. WSGopher determines which window is 
next according to the order in which you opened the windows.

Shortcuts

Keys: CTRL+F6

_________________
See also
Controlling your Windows environment



Previous window

Use this command to switch to the previous open document window. WSGopher determines which 
window is previous according to the order in which you opened the windows.

Shortcuts

Keys: SHIFT+CTRL+F6

_________________
See also
Controlling your Windows environment



Close window (control menu)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

  

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time. You can close all windows at once with the Close 
command on the File menu.

Shortcuts

Keys: CTRL+F4 closes a document window
ALT+F4 exits the WSGopher application
ESC also closes a document window or dialog box

_________________
See also
Controlling your Windows environment



Restore window (control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.

_________________
See also
Controlling your Windows environment



Switch to (Application Control Menu)

Use this command to display a list of all open applications. Use this "Task List" to switch to or close an 
application on the list.

Shortcuts

Keys: CTRL+ESC

Dialog Box Options

When you choose the Switch To command, you will be presented with a dialog box with the following 
options:

Task List Select the application you want to switch to or close.
Switch To Makes the selected application active.
End Task Closes the selected application.
Cancel Closes the Task List box.
Cascade Arranges open applications so they overlap and you can see each title bar. This 

option does not affect applications reduced to icons.
Tile Arranges open applications into windows that do not overlap. This option does 

not affect applications reduced to icons.
Arrange 
Icons

Arranges the icons of all minimized applications across the bottom of the 
screen.

_________________
See also
Controlling your Windows environment



Main Window

Need help getting started?

If your WSGopher window is empty, and you pressed F1 because you needed help, then this is what you 
do:

Learn how to set a Home Gopher Server
Visit your Home Gopher Server
Fetch interesting itemswith the Fetch Bookmark menu

Title Bar

At the top of the window you will see the title bar. It contains the name and version number of this 
application; currently that is "WSGopher 1.1". When you have a Gopher document window open, then the 
title of that window appears in the title bar as well.

Menu Bar

Below the title bar is the menu bar. It contains:

File    Edit    Bookmark    Configure    Window    Help

To select an item in a menu, click on the menu with the left button. For instance, to get the File menu, 
click on the word "File". You can also use the ALT key and the underlined letter of the menu; in other 
words, press and hold the ALT key and the letter 'f' to get the File menu.

See the topic Getting Help below for a shortcut on finding out what the items in menus do.

Toolbar

Below the menu bar is the Toolbar. This contains a set of buttons with graphics; each button is identical to 
one item in one of the menus. The reason for a toolbar is to provide a shortcut to commonly used 
functions.

Client area

Between the Toolbar and the Status Bar is the client area. WSGopher puts individual document windows 
in this area. If windows are minimized, the icons fill in this area from the bottom left, working right and up. 
If a window is maximized, it fills this area.

Status Bar

At the bottom of the WSGopher window is the Status Bar. Usually it says "WSGopher is ready ... press F1 
for help". That may be how you ended up in this help screen.

However, at other times it contains different text. Sometimes while WSGopher is going about its business 
it may display a different message here. It pays to keep an eye on the Status Bar.

_________________
See also
Getting Help



Title bar

  

The title bar is located along the top of a window. It contains the name of the application and document.

To move the window, drag the title bar. Note: You can also move dialog boxes by dragging their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button

_________________
See also
WSGopher Main Window



Overview of Directory window

A Gopher directory contains one or more Gopher items. Specifically, you will see a bitmap like  , 
 or 

    on the far left side of the window, and next to it will be text. The bitmap represents the type of the 
Gopher item, and the text is the title of the item.

The directory appears in a scrolling list window. If a scroll bar appears to the right, you can scroll up and 
down to see more items. If a scroll bar appears on the bottom, you can scroll left and right to see the full 
text of the titles.

You can also resize the window; depending on the number of items and the length of the titles, the scroll 
bars may disappear or reappear.

What can you do with a directory?

First, you need to select the item. Then you typically fetch items or get information.

You can copy the contents of a directory to the clipboard; when you do, the titles are copied.

Similarly, you can print the contents of a directory; when you do, the titles are printed.

Keyboard Shortcuts:

UP Previous item
DOWN Next item
PAGE UP Up one screen
PAGE DOWN Down one screen
HOME First item
END Last item
ENTER Fetch item
ESC Close window

_________________
See also
What is Gopher?
Introduction to WSGopher
Bookmarks



What the bitmaps mean

Below you    will find the bitmaps, or icons, used in a Gopher directory, along with a brief description. In 
almost all cases you can click on the bitmap to get more help for that Gopher item.

Bitmap Explanation

  This is a Gopher directory.

  This is a Gopher text file.

  
This is a Gopher phone book interface; it is interactive.

  
This is a Macintosh "binhex" file; it probably won't do you much good unless you are 
using a Mac.

  
This is a DOS archive of some sort; it seems that "zip" files are pretty typical.

  
This is a Unix "uuencoded" file. I have yet to see an example of one in Gopher, 
although I've used them on Unix systems.

  This is a Gopher index search interface. The text to the right of this icon represents the 
database you will be searching.

  
This is a "telnet" login session, or will be when you select it. You need to have a 
WinSock 'telnet' client installed on your computer.

  
This is a "3270" session, or will be when you select it. You need to have a 3270 
emulator installed on your computer.

  
This is a binary file; the type is not known.

  This is an image; GIF and JPG images seem to be the most common. You will need 
viewers    to see these images.
This is an Adobe Acrobat file; you will need to get the reader application from Adobe.    
Gopher supports these files as an alternative hypertext document .

  
This is a movie file. MPEG seems to be pretty common, but you might run into 
QuickTime format; you will need a viewer to see the movie.

  
This is a sound file. There are a variety of formats, and many viewers to choose from.

  
This is a MIME file; MIME is used in email, but I suppose a viewer would tell you what 
was included in this "message".

  
HTML, or Hypertext Markup Language, is used in the World Wide Web. Gopher 
servers can download HTML descriptions of directories; in the future, WSGopher will 
probably be able to display HTML. For now you'll need a Web client such as Cello or 
Mosaic.

  
This is the Panda "inline" type; the text associated with it is a comment, and there is 
nothing to download.

  
This is an Ask form, the    Gopher+ interactive form.

  
You will see this when the server returns an error; most typically when a Veronica 
server is too busy to handle your request, or for a Gopher directory that is under 
construction.

  
 WSGopher did not recognize this Gopher type; if you think this is in error, please send 
a copy of the bookmark    via email to gopher@tis.inel.gov

_________________
See also
Overview of the Directory window



Selecting an item in a Directory window

You select an item in a directory window by clicking on it with the left mouse button.

Once you    have clicked on an item, you can use the Up and Down arrow keys to select items above or 
below it, or continue clicking to select.

If you double click on an item, this is the same as selecting it then fetching it.

_________________
See also
Overview of the Directory window



Fetching an item in a Directory window

Once you have selected an item in a directory, you can fetch it with the ENTER key, or the   Toolbar 
button, or you can use the File menu and select Fetch Item. This means that WSGopher makes a 
network connection to some host computer on the network, then sends it a request, then gets the results 
and displays them for you.

While this is going on, WSGopher also creates a window to put the item in.

New: starting with version 1.1, WSGopher keeps track of the currently open windows. If you fetch an item 
from a directory, and you already have a window open for that item, WSGopher now brings that window to 
the front rather than refetch it. If the item is Gopher+, then WSGopher also considers the view, so you 
could have more than one window for an item so long as they have different views.

_________________
See also
Overview of the Directory window



Getting information on an item in a Directory window

After selecting an item, you may get more information on it by clicking the   button in the Toolbar. Starting 
with WSGopher 1.1, you need to select the item in the directory again, after you bring up the information 
window.

While the Information window is visible, then each time you select an item in any directory, it's information 
will appear in the Information window.

_________________
See also
Overview of the Directory window



Overview of Text window

A Gopher text document contains plain, ASCII text. There are several common uses for text documents:

README files, Indexes to directory contents, general information
Text returned from searches

Text documents have both horizontal and vertical scroll bars which appear in case they are needed. You 
can drag the button in the scroll bar in the usual way. Text document scroll bars also support the following 
keyboard actions:

Key Action
HOME Goes to top of document
END Goes to end of document
PAGE UP Goes up one screen
PAGE DOWN Goes down one screen
UP ARROW Goes up one line
DOWN ARROW Goes down one line
LEFT ARROW Scrolls left one column
RIGHT ARROW Scrolls right one column
ESC Close window

_________________
See also
Selecting text in a Text window



Selecting text in a Text window

1. Using the scrollbar or the positioning keys, position the text in the window so that you can see where 
you want begin selecting.

2. Move the cursor to your starting point.
3. Hold down the left mouse button and begin to drag the cursor. The selected text is highlighted.
4. You may go out of the window, so long as the left mouse button stays down. If you go above or below 

the window, the text will scroll up or down until it reaches the end/beginning of the document.
5. Release the left mouse button to mark the end of the selection.

Note that while you are selecting, the starting point and current point are displayed in the text window's 
Status Bar. When you finish, the starting and ending point are displayed, in terms of line and column.

To cancel selecting text

To cancel selecting text, click the right mouse button.

To unselect text

To unselect the selected text, you can do one of the following:

Click the right button, which makes the window 'forget' about the text selection
Click the left button, which displays the current line and column
Double click the left button, which selects a word
Start a new selection

_________________
See also
Overview of Text window



Overview of Download window

Images, DOS archives, Unix uuencodeded files, Mac BinHex ('hqx') files and binary files all have one 
thing in common in WSGopher:    they are downloaded to your computer, where WSGopher or you can 
run an appropriate program to view or edit the file. Or, perhaps you just wish to store it for later use.

Steps for downloading a file

Select the file from a Gopher directory, or the Bookmark Editor, or a bookmark of your choosing. 
WSGopher will construct a legal DOS filename from the title of the item you fetched. Here's how that 
works:

1. WSGopher looks for a file extension in the name, such as '.GIF', '.HLP', etc. Case is not important. If 
there is no extension, then Gopher will guess using the item type.

2. WSGopher then starts at the beginning of the title and gets the first eight legal DOS filename 
characters, until it encounters a period.

3. WSGopher makes a set of filename "filters" for the file dialog box entitled 'Select File for Gopher 
Download'. If the title contains '.GIF' then the filter will show GIF files; or, if the item type is 'Image', 
then the filter will contain entries for GIF, JPG, MPG, etc.

4. WSGopher then displays the file dialog box. The default directory is the Gopher Download directory, 
which can be set in the Configure menu by selecting 'Local Directories'.

Use whatever filename or directory you wish. If you enter an invalid name, the file dialog will tell 
you. If you press the OK button, Gopher will download the file. If you press the Cancel button, Gopher will 
forget about downloading this file.

Working with the Download Box

A dialog box appears containing the name of the file you selected, and several toggle buttons. You'll 
notice that the Download Box shows how many bytes have been transferred and how fast the download 
is progressing. When the transfer is complete, the Download Box will add ' ... done' to the display.

If you wish to view the file when the download is complete, click on the 'View file when complete' toggle.

WSGopher will delete files you download, unless you tell it not to. If you wish to save this file for later use, 
then click on the 'Save file for later use' toggle.

_________________
See also
Choosing a filename
Viewing the file
Viewers
Saving the file for later use



Choosing a filename

How WSGopher creates a filename

WSGopher attempts to build a filename from the Gopher item's title, the text you see in the Gopher 
directory. Here are the steps it follows:

If the title has a period ('.') then WSGopher uses text to the right as an extension, and text to the 
left as the filename

Otherwise if the title has forward slashes ('/') or backslashes ('\') WSGopher uses the part of the 
text after the last of these as the filename

Otherwise WSGopher uses the first eight DOS filename characters, from the title, as the 
filename.

If WSGopher can't determine a file extension from the steps above, then it uses the following rules:
If the item is fetched using an extended view, and the view is configured with a file extension, the 

WSGopher uses this
Otherwise WSGopher uses one or more extensions based on the item type.

Using your own filename

WSGopher uses a standard Windows File dialog box, so you can use your own filename, and select your 
own directory. This is helpful particularly if you disagree with the extension WSGopher used; just type in 
your own.

If the file already exists ...

WSGopher puts up a dialog box advising you if the file already exists. If you wish to overwrite it, click the 
Yes button; otherwise click No and you will have another opportunity to change the filename.

_________________
See also
Editing extended views
Overview of the Download Window



Viewing the file

If the "View file when download is complete" toggle, in the Download box, is on when the file transfer 
finishes, then WSGopher will attempt to view the file.

Finding a viewer

These steps explain how WSGopher finds the viewer program:
· If the file was fetched using an extended view, WSGopher will use the viewer program configured for 

that view, if any.
· Otherwise WSGopher checks its own viewer configuration using the file's extension
· If WSGopher doesn't find a match there, then it uses the File Manager associations

Running the viewer

If WSGopher has a problem running the viewer program, it pops up a dialog box containing the path of 
the viewer and the name of the file you just downloaded. This is a good opportunity to check your 
configuration and correct the path for the viewer.

_________________
See also
Editing extended views
Viewers
Overview of the Download Window



Saving the file for later use

If the "Save file for later use" toggle is set, then WSGopher will not delete the file you downloaded when it 
exits.

The Delete Files selection in the File menu gives you access to the files you have downloaded, in case 
you change your mind.

_________________
See also
Deleting downloaded files
Overview of the Download Window



Overview of Phone Book window

Gopher provides an interface to a service called CSO, which existed before Gopher was created. CSO is 
commonly used to provide white pages lookup of names, phone numbers, email address, etc. Think of 
'white pages' as looking up something by name, and 'yellow pages' as looking up something by service 
category (not to mention a term copyrighted by the phone company).

The Phone book window contains an area to enter a search string, a droplist labeled Fields, and a 
scrolling list where results will be displayed. As with Search windows, the easiest query is the simplest. 
[Important note: your results may vary depending on how the server is set up!] 

The Phone book is interactive; this means you can pose many queries. The results for each query appear 
in the scrolling list.

The Phone book is resizable, and you can change the font if you wish.

_________________
See also
Entering a Phone Book query
Using the results of the Phone Book query



Entering a Phone Book query

Getting started

First try entering the last name of the person you are looking for (or your own if you are just browsing). 
Depending on the data this CSO server has stored in it, you may get quite a few responses. Now you can 
use the scroll bar to look at the information returned to you.

Narrow your search

Let's say that instead you get a message similar to the following:

Too many entries to print.
Bye!

Or, perhaps you received a long list and wish to narrow your search a bit.

Let's take a quick look at the Fields mentioned above. For the sake of example, let's say you entered 
smith as a search string, and all you remember about the person is that their name started with "B". Now, 
go to the Fields droplist. Click the mouse on the down arrow, and you'll see a scrolling list "drop down" 
(hence the name). Click on the first item in the list, which should be "name". In the search field we now 
have

smith name=

Type in b* after the equal sign, so that it looks like this:

smith name=b*

and click the Search button. You may get a smaller list, or you may get

No matches to your query.
Bye!

If you get this, you might try experimenting until you find at least one match.

Let's say that one of the matches look similar to the following:

name: Smith, Greg
      title: Engineer

It occurs to you that you may know someone else named Smith who is an engineer. Erase name=b* in 
your search query. Go to the droplist again and select the entry for "title", and after the equal sign type 
'engineer'. Your query now looks like:

smith title=engineer

Click the Search button again and you'll see how many Smiths have 'Engineer' in their title.

You can search without using the name at all. Consider that Greg Smith is in the Safety department, that 
is

department: Safety

was returned for him. You could easily list the entire Safety department by changing your query to



department=safety

Then you could find out who the manager was like so:

department=safety title=manager

This might also list the Assistant Manager, if there was one.

Note: for most of the CSO servers I've visited, an entry such as 'smith' without a field and equal sign 
means 'name=smith'.

Note: the way you enter queries containing spaces is to repeat the field name. We could search for Greg 
Smith like so:

name=smith name=greg

Note: the CSO server you connect to may not use name as the default search field; unfortunately, there is 
no way to tell what the servers default search field, or if it even has one.    So, our examples above 
starting with smith may not work.

_________________
See also
Phone book



Using the results of the Phone Book query

The Phone book places results in the scrolling list. You can select multiple lines with this list, just like you 
can with the Bookmark Editor.

You can copy Phone book results to the Windows clipboard; if you have selected lines, only those lines 
are copied.

You can print Phone book results; if you have selected lines, only those lines are printed.

_________________
See also
Phone book



Overview of Search window

You can search databases on other computers with Gopher. Often the remote computer has a WAIS 
database, where WAIS stands for Wide Area Information Service. Just the same, all you really know 
about the remote database is that you can do keyword searches on it, and the result will be one or more 
documents that contain your search text (hopefully!).

What happens when you search

Each time you enter a query and click the Search button, WSGopher creates a directory window, fetches 
the results and puts them in the directory. The name of the directory is the name of the search item, with 
your search query added at the end; a colon separates them.

It often takes awhile for the search to complete, so be patient!    The database server does the query 
when you ask; it's not the same as fetching something that already exists on a Gopher server.

_________________
See also
Entering a Search query
Using the results of a Search query



Entering a Search query

Here are some common tools which will help you with most searches. Your results may vary; for more 
information, contact the administrator of this Gopher server. You can usually find out who that is, if the 
directory is Gopher+, by using the Information window on the main Gopher window for that server.

Single word

The simplest search is also the easiest. To look for a single word, just type that word. For instance, if you 
are looking for Idaho, then just type

idaho

and click the Search button. I did this just now in Veronica and got 400 entries. There are probably more 
(the Veronica documentation tells you how to increase the number of return documents).

Words found together

If you are interested in Idaho forests, you would enter

idaho AND forest

I did this just now in Veronica and got 56 entries. Each one contains 'Idaho' and 'forest'. Similarly, you 
could enter

idaho OR forest

if you were interested in entries with 'Idaho' or 'forest', but the entries did not have to contain both.

Exact text

To search for exact text, that is two or more words that must follow each other, enclose the text in double 
quotes like so:

"private forest"

Again, just now this resulted in 161 entries (I am not advocating 'private forest', by the way).

_________________
See also
Search
Using the results of a Search query



Using the results of a Search query

The results of a Search query are placed in a directory window. The only useful thing you can do is to 
fetch items from the directory, or fetch the top Gopher menu for items in the directory.

Do not save a bookmark for the directory; it makes more sense to save the bookmark for the search 
window itself.

_________________
See also
Search
Entering a Search query



Telnet Information Window

When you fetch a telnet or 3270 emulation, WSGopher shows you the Telnet Information window. There 
are several reasons for this:

If the Gopher administrator provided any hints, such as a login ID and password, WSGopher will 
show you the hints in this window.

When you start the emulation by clicking the Start button, you can be assured that the emulator's 
window will appear in front of WSGopher.

When you start the emulator, WSGopher shows you a copy of the command line in the Status Bar for the 
Telnet Information window. This may help you debug your setup if you experience problems running the 
emulator.

_________________
See also
Terminal emulation
Telnet/3270 path





Print command

Use this command to print a document.      This command presents a Print dialog box, where you may 
specify the range of pages to be printed, the number of copies, the destination printer, and other printer 
setup options.

Shortcuts
Toolbar:  
Keys: CTRL+P



Print dialog

The following options allow you to specify how the document should be printed:
Printer This is the active printer and printer connection.    Choose the Setup option to 

change the printer and printer connection.
Setup Displays a Print Setup dialog box, so    you can select a printer and printer 

connection.
Print Range Specify the pages you want to print:

All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies Specify the number of copies you want to print for the above page range.
Collate Copies Prints copies in page number order, instead of separated multiple copies of 

each page
Print Quality Select the quality of the printing.    Generally, lower quality printing takes less 

time to produce.



Print Progress dialog

The Printing dialog box is shown during the time that WSGopher is sending output to the printer.    The 
page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview

Use this command to display the active document as it would appear when printed.    When you choose 
this command, the main window will be replaced with a print preview window in which one or two pages 
will be displayed in their printed format.    The print preview toolbar offers you options to view either one or 
two pages at a time; move back and forth through the document; zoom in and out of pages; and initiate a 
print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print Bring up the print dialog box, to start a print job.
Next Page Preview the next printed page.
Prev Page Preview the previous printed page.
One Page / Two Page Preview one or two printed pages at a time.
Zoom In Take a closer look at the printed page.
Zoom Out Take a larger look at the printed page.
Close Return from print preview to the editing window.



Print Setup

Use this command to select a printer and a printer connection.    This command presents a Print Setup 
dialog box, where you specify the printer and its connection.



Print Setup dialog

The following options allow you to select the destination printer and its connection:
Printer Select the printer you want to use.    Choose the Default Printer; or choose 

the Specific Printer option and select one of the current installed printers 
shown in the box.    You install printers and configure ports using the 
Windows Control Panel.

Orientation Choose Portrait or Landscape.
Paper Size Select the size of paper that the document is to be printed on.
Paper Source Some printers offer multiple trays for different paper sources.    Specify the 

tray here.
Options Displays a dialog box where you can make additional choices about printing, 

specific to the type of printer you have selected.
Network... Choose this button to connect to a network location, assigning it a new drive 

letter.
Page Setup

Page setup determines how the printed page will appear.

First, the margins determine the amount of white space that surrounds the printed material.    This is a 
fractional value, so "0.5" is one half inch.

You can selectively turn headers and footers on or off.    If the Print the Header toggle is turned on, 
indicated by an X in the box, then WSGopher puts the title of the document at the top of each page; a 
horizontal line appears under the title.

Similarly, if Print the Footer is on, then WSGopher puts the text "Page " followed by the page number at 
the bottom of each page.    A horizontal line separates the document text from the page number.

_________________

See also

Printing in WSGopher
Print Setup
Print Preview



Understanding error messages  

Errors happen from time to time, even to the best of us (or so I've heard). Having a basic understanding 
of what is happening may help you find the problem and come up with a solution.

Network errors

The topic on fetching Gopher items describes in some detail how WSGopher uses the network. The See 
also section below also lists specific network error message topics.

Couldn't run <application>

If WSGopher tries to run an application, such as a viewer or terminal emulator, and if Windows tells it that 
the application will not run for some reason, then WSGopher pops up an error window. The command line 
(which should include the path of the application) and the text that corresponds to the Windows error are 
in the error message window.

The most likely problems are that the path is incorrect, or that there is not enough memory to run the 
application. The former seems to happen much more often than the latter.

File errors

File errors are going to be rare, because WSGopher does very little with files. Text documents are saved 
to disk, and download files are written to disk; you may occasionally experience an error if your disk fills 
up or encounters a bad spot. These errors can only be addressed on a case by case basis.

WSGopher has been tested with and without the DOS "Share" program.

Reporting errors

If your network software crashes while running WSGopher, please report the problem to your network 
software vendor. Be sure to include WSGopher's version number, and tell them where they can get a 
copy if they don't already know.

If you cannot view something you downloaded, this is probably not a WSGopher problem; try getting 
some local help.

If you find a problem that you can repeat, then please include the following information in your email to 
gopher@tis.inel.gov:

Describe the problem as specifically as you can. 
Usually there is a specific item that doesn't work as you expect. Please copy the bookmark for 

this item to the Windows clipboard, and then paste it into your email message. 
Using the WinSock info window, copy the vendor version information to the Windows clipboard, 

and paste this information into your email message.

_________________
See also
Can't talk to WinSock
Out of Network Resources
Hostname lookup failure
Possible WinSock failure



Can't connect
Connect error to host
Error sending request
Gopher server error



Out of Network Resources

What happened:

No one who has ever gotten this message thinks they should have. Just the same, for whatever reason 
your network software has told WSGopher that it cannot create a new socket. A 'socket' is the 'pipe', so to 
speak, that WSGopher and the Gopher server use to send data back and forth.

Possible solutions:

If your network software is TSR based, that means if it loads into DOS memory before you start 
Windows, contact your vendor for an update, or work with your local guru on optimizing the DOS memory 
below 640K.

Try quitting one or two large applications before fetching the next item in WSGopher.
Contact your vendor for help.

_________________
See also
Understanding error messages



Hostname lookup failure

What happened:

WSGopher has asked your network software to look up the Internet address for a hostname, and your 
network software replied that it could not.

Possible solutions:

If you get this error immediately, and you notice that the hostnames always end with a period ('.'), 
then check your User Options window; WSGopher has an option to help with this.

Use the Information window to check the hostname. Occasionally you will find a hostname with a 
leading space or other character. Use Fetch Item As in the File menu to get the item, paying attention to 
the Host field; then contact the Gopher administrator for this item, and report the problem.

Check your network software to make sure you have the right Domain Name Server(s) (aka DNS) 
in your setup. Your network guru can help you.

Ask your network guru for help concerning the hostname you are having problems with.

_________________
See also
Understanding error messages



Possible WinSock failure

What happened:

With some older WinSock network software, sometimes the host information returned contains some 
illegal values. Rather than crash, WSGopher puts up this error message.

Solution:

Contact your network software vendor for an update.

_________________
See also
Understanding error messages



Can't connect

What happened:

This is an unlikely situation, but WSGopher tried to connect to the Gopher server, and was not able to 
even make the request.

Possible solutions:

Check the topic on Network Resources.

_________________
See also
Understanding error messages



Connect error to host

What happened:

WSGopher requested your network software to connect to the Gopher server, and the software learned 
that it could not for some reason. It told WSGopher, and WSGopher is telling you.

Possible solutions:

The most likely reasons are:
The Gopher server, or the local network the server is on, is just too busy right now. You should try 

again later.
The server is not running right now; that could either be the Gopher server software, or the host 

computer itself. Try again later.
You are using the wrong port; this is very likely if you get an immediate response with the text 

"Connection refused." If you copied a bookmark and pasted it into WSGopher, make sure you copied the 
port. Otherwise, try contacting the Gopher administrator.

_________________
See also
Understanding error messages



Error sending request

What happened:

WSGopher sends some text to the Gopher server, indicating what item you wish to fetch. For some 
reason this resulted in an error.

Possible solutions:

The possible reasons for this error range from losing your network connection to having a Gopher server 
host stop running. It is far more likely that one of the other network errors would have happened, rather 
than this one.

Try to isolate the problem by fetching items from several servers. Chances are, if the problem is local, 
then you will not be able to fetch anything. If you only have problems with certain hosts, then you might 
report the problem to your local network guru.

_________________
See also
Understanding error messages



Can't talk to WinSock

What happened:

Windows Sockets, aka WinSock, is the network software on your computer that allows WSGopher to talk 
to the network. For some reason WSGopher is not able to communicate with WinSock at this time.

Possible solutions:

The file WINSOCK.DLL needs to be in a directory on your DOS PATH. Check your installation to 
make sure the networking software is properly installed. You might get assistance from your local PC 
guru.

Possibly, your local network is down, or the network device in your computer is not working. Get 
assistance from your local network administrator.

_________________
See also
Understanding error messages



Gopher server error

What happened:

A Gopher plus server has just informed you that it cannot give you the item you are trying to fetch. The 
message box contains some explanatory text.

Possible solutions:

The reasons it may give include:
1. The item is not available, that is, it doesn't exist. Either you are retrieving a file that is being 

updated, and you came at a bad time, or your bookmark is out of date. Search around and try to find 
the item, then update your bookmark.

2. Please fetch this item later, when the server is less busy.    Try again later.
3. The item has moved. Use the new location to fetch the item.

The Gopher server usually returns the administrators email address. Contact this person if you need to, 
but try to do so as a last resort.

_________________
See also
Understanding error messages



What is Gopher+?

After the original Gopher was used for a period of time, the Gopher Team at the University of Minnesota 
decided to add some features to address various needs. These features are often called Gopher+, and 
the original set of Gopher features are sometimes called "Gopher Plain" or Gopher0. Eventually it will all 
be called Gopher.

Gopher+ features can be divided into two categories: extended information and new interactive items. 
Extended information is really more information; for instance, a Gopher server might tell you who 
administers it; or, an item might be available in several formats. The interactive items are described 
below.

Extended information

A Gopher+ server may provide a variety of new information. The actual bytes look something like 
"+ADMIN" or "+ABSTRACT". WSGopher interprets a number of these, and passes the rest along 
unchanged. The following table shows many of the items, and what WSGopher does with them.

Bytes Action
+INFO Realizes that extended information is present, but doesn't show you the bytes
+ADMIN Shows you "Administrative info:" and whatever subcategories may be present
+ABSTRACT Shows you "Abstract:" and the abstract text
+VIEWS Shows you "Extended view info:" and lists the views as they appear. Note that 

many views include the size of the item.
+ASK Shows you "Ask info was found" but not all the boring Ask form setup. 

WSGopher processes this stuff and keeps it; if you fetch the Ask item, 
WSGopher first creates a form window using the setup.

One of the most frequently used items are the extended views. With extended views the Gopher 
administrator can offer an item in a variety of forms. For instance, a text file might be available as plain 
text, and PostScript, and a word processor format. Only one item would appear in the Gopher directory, 
and WSGopher can automatically select the 'right one' based on the users preferences.

Interactive items

Gopher+ defines a new interactive item, the Ask form. The form is like a dialog, containing text, items to 
select, and fill-in-the-blank data. Once you fill in the form, you click the Send button. Then WSGopher 
sends your data to the Gopher server and retrieves an item for you.

With Ask forms, the Gopher administrator can support advanced queries, data entry, maintenance of 
various types, enrollment and registration, and many more kinds of interaction.

_________________
See also
Getting information on an item
Getting extended information
Extended views
Ask forms



Extended views

Extended views allow Gopher to provide information in an almost unlimited variety of ways. It does this by 
adding views on the basic Gopher types, or other means of 'looking at' a given piece of information. Any 
Gopher item can have one or more views; you fetch the item using one of those views.

A view contains the following pieces of information:
a unique name, such as 'application/msword' or 'file/zip'
an optional language, such as EN_US (for English U.S.) or FR_FR (for the French they speak in 

France, as opposed to Belgium, Canada or Switzerland)
an optional size, expressed in 'K', or 1024 bytes; a 100K file would be about 102,400 bytes

WSGopher adds more information to views, including:
The native Gopher type this view corresponds to
The viewer program used to look at data in this view, if WSGopher doesn't handle it itself
The file extension that this view should be saved to disk with, if appropriate
The ranking, or preference, associated with this view

For the sake of example, and to help acquaint the user with views, we'll offer some representative 
examples. This is not an all-inclusive list and the information may be subject to change.

Directory views

View Meaning
application/gopher-menu Standard Gopher menu
application/gopher+-menu More extensive, Gopher+ menu; includes extended information on 

items in the menu
text/html An HTML page containing the items in the directory and the 

associated URL; currently, you need a viewer such as Cello or 
Windows Mosaic to use this

Directory/recursive Standard Gopher menu containing all the items on this Gopher 
server

Directory+/recursive Gopher+ menu containing all the items on this Gopher menu, and 
the extended information for the items

Text views

View Meaning
text Plain text, just like the 'normal' Gopher text item
text/plain Same as text
text/rtf Rich Text Format
text/postscript PostScript; probably requires a viewer like GhostScript
application/microsoft-write Windows Write format

A number of proprietary word processor formats are also supported.

Image and movie views

View Meaning
image/gif GIF
image/JPEG JPEG
image/pcx PCX
image/eps Encapsulated PostScript
video/mpeg MPEG movie format
video/quicktime QuickTime movie format



There are many more image formats than shown here.

What are you expected to do with views?

WSGopher is configured so that you do not need to think about views; WSGopher will try to do the 'right 
thing' with the extended view information it receives from the Gopher server. The User Options dialog 
controls whether WSGopher will figure this out on its own, or will always need your intervention.

With this configuration, you will only need to select a view if none of the views for an item have a ranking 
(or preference). Similarly, you will never see the Extended View Editor unless you select a view that 
WSGopher does not have in its configuration.

However, WSGopher supports all the operations you need to control the extended views. 

_________________
See also
User options
Selecting an extended view 
Editing extended views
Ranking extended views
Language used in extended views



Getting extended information

When you fetch an item, WSGopher checks the "Gopher plus" attribute. If it is set, and the item does not 
have any extended information associated with it, then WSGopher first retrieves the extended 
information. Then WSGopher will fetch the item using the new information.

_________________
See also
What is Gopher+?
Extended views



Overview of Ask form window

Gopher+ defines an interactive form called an Ask form; sometimes you will hear it called an "ask block". 

The purpose of an Ask form is to provide detailed information, from the user to the Gopher administrator. 
The way you interact with an Ask form in somewhat like a Windows dialog, in that you provide information 
in a variety of ways. You may type one or more lines, or you may toggle something on or off, or you may 
pick one of many. You can click a button and see yet another dialog.

Unlike a Windows dialog, Ask form windows in WSGopher have scroll bars, and you cannot currently use 
TAB or SHIFT-TAB to go from field to field.

Specifically, you will see the following kinds of items in an Ask form:

Item Purpose
Text Serves as a prompt, or explanation of other items
Single line text 
entry

Fill in one line. The Gopher administrator can specify a default value which 
is filled in for you.

Multiple line text 
entry

Fill in one or more lines; note the vertical scroll bar on the right side of this 
field

Password single 
line text entry

When you enter this line, you will not see anything typed on the screen.

Toggle A setting you will turn on or off. The Gopher administrator specifies 
whether it is on or off by default.

One of many 
(radio button)

Select one of the small, circular buttons. WSGopher selects the first one by 
default. Only one can be selected at a time.

Choose a file Use the browser button      to select a file on your hard disk. WSGopher 
will upload    this when you complete the Ask form.

Text vs. Binary

When you choose a file via the Browser button, WSGopher attempts to determine if the file is text or 
binary. It reads part of the file and looks for characters normally associated with binary files. The reason it 
does this is because most Gopher+ servers can handle uploading text files, but only some (at of 
November 1994) can handle uploading binary files.    Hopefully this situation will change soon!

You can override WSGopher's judgement by selecting one of the settings. It is hard to say what results 
you may get if the Gopher server does not agree with you!

Completing the form

When you have supplied all the information you intend to, click the Send button at the bottom of the Ask 
form. WSGopher will send the information in the form to the Gopher server, and will open another window 
to receive the results.

The results of filling in the form

Typically, the results of the Ask form will be a text window containing messages from the Gopher server. 
However, you could get any Gopher item.

_________________
See also
Dialogs



Selecting an extended view

WSGopher may display a window containing a list of views. Each view will contain the name of the view, 
in the left column; you may also see the language for this view, and the optional size enclosed in angle 
brackets ('<' and '>').

To fetch the item with one of the views, select the views and click the OK button, or double-click on the 
view. If you select a view that WSGopher does not have in its configuration, it will pop up the Extended 
Views Editor. Enter what you need to and click the Add button, then the OK button.

To not fetch, click the Cancel button.

_________________
See also
What is Gopher Plus?
Extended views
Getting extended information



Splash Window

The Splash window is the dialog that comes up when you first start WSGopher. It contains copyright and 
version information.

The Splash window goes away on its own after a few seconds. If it does not, you can click inside the 
WSGopher main window and wait; if it still doesn't go away, you might try rebooting your system and 
running WSGopher again.

The picture of the Happy Gopher is the property of the University of Minnesota and is used with 
permission.    Ken Blackney colorized it for me. Contrary to popular opinion, it is not a self portrait!

_________________
See also
Introduction to WSGopher
The About box



WSGopher Features

Fast, stable, reliable Gopher+ client program.
Fully threaded or multitasking -- you can retrieve as many items at a time as your network allows.
WYSIWIH, or 'What you see is what I have' - Data is available to the user as it arrives on their 

computer; there is no waiting and no hourglass cursor while an item is downloading. In directory windows, 
the user can scroll and fetch items from the menu while the directory is downloading. In text windows, the 
user can scroll and mark text while the text is downloading.

Context sensitive help -- get help for the item you are working on with a keystroke or mouse click. 
Get help for any Gopher window, dialog, menu item or toolbar button.

Supports all Gopher types, including phone book. Internal viewers for text and phone book; text 
viewer supports up to 32K lines.

Easy use of Gopher+ features, and easy to use configuration and setup dialogs.
Gopher+ support includes "Ask forms" in a scrolling window. Ask forms include all defined types, 

including "ChooseF", allowing the user to upload a file from their computer to the server.
Uses Windows Multiple Document Interface (MDI), with a customized document window for each 

Gopher item type.
Easy to fetch/save/ edit bookmarks. First to support categories of bookmarks.
Supports printing, including Windows Print Setup, landscape and portrait, printer options, print 

preview, print using window or printer font.
Supports copy to Windows Clipboard, both full documents and selected areas.
Viewers for downloaded items can be configured in WSGopher, but by default it will use the File 

Manager configuration.
Windows can be stacked, tiled, minimized and maximized. WSGopher also keeps a list of current 

documents by title, so that an existing window can be easily located and brought to the front.
Windows with network activity have their own Status Bar for progress messages. 
Network activity is not affected by altering the window; however, closing a window safely cancels 

network activity if it is in progress.
Gopher item type is always represented in a drop list, never as a code the user has to 

understand and enter.
Supports Boolean text search within a window.

Directory

Items shown in a scrolling list, supports roughly 8k items. Item type is denoted by a bitmap. The 
directory window is resizable.

Directory supports keyboard as alternative to mouse, including Page Up, Page Down, Home, 
End, Next, and Previous.

Double clicking the item is a shortcut to fetching the item.
List can be scrolled horizontally if needed.
Directory can be printed or copied to the Windows Clipboard.

Text

Text font can be easily specified with the standard Windows font dialog.
The entire text document can saved to disk, printed or copied to the Windows Clipboard. For the 

sake of consistency, this is only possible when the document is finished downloading.
Text can be marked with the mouse, via press-and-drag (window scrolls up or down as needed), 

or double click to select a single word. Marked text can be saved to disk, printed or copied to the 
Windows Clipboard. You can mark text, and copy/save/print it, even if the document itself is still 
downloading.

While marking, the text document's Status Bar shows in 'line:column' format where the start and 
current positions are. If your starting and ending points are the same, then the current position in the 
document is displayed and no text is marked. 

Text marking is supported whether the current font is fixed or proportional.
A legal DOS filename is determined from the title (if possible) and supplied to the user when 

saving to disk.



Window can be resized, and supports both vertical and horizontal scrolling.
Keyboard keys including Page Up, Page Down, Home, End, Next, Previous, Left, and Right are 

supported.

Search

The search string is 'remembered' between queries and between sessions.
A query opens a directory window whose title is the query title plus the query text; this makes it 

particularly easy to refine queries, and to launch parallel queries.

Download (Images, DOS archives, etc.)

A legal DOS filename is determined from the title. If the title includes an extension, then that is 
used; otherwise WSGopher supplies a default using the document type. The standard File Open dialog 
box is used to specify the filename; WSGopher supplies a reasonable set of filters plus one matching the 
file extension.

Files may be viewed when download is complete; this can be repeated as often as the user likes.
Files may be saved on disk for future use; by default, downloaded files will be deleted when 

Gopher exits, or the user can select the Delete Files item in the File menu.
The Delete Files dialog lets the user change the Save/Don't Save setting for downloaded files, 

and lets the user delete marked files now instead of waiting for Gopher to exit. Also, the cumulative size in 
bytes of the marked files is displayed.

WSGopher uses File Manager associations to select the proper viewer for a file. The user can 
override this selection with the Viewers item in the Configure menu.

The directory where downloaded files are placed is configurable; defaults to the working directory, 
or use the Local Directories item in the Configure menu to override.

Phone Book

The Phone Book is an internal viewer, and supports copying results to the Windows Clipboard 
and printing. The window is resizable.

When the document window is created, the viewer connects to the CSO server and downloads 
the 'fields' supported by that server. These fields are then put in a standard Windows "drop list" where 
they can be used to assist in forming queries.

Return information is parsed to eliminate most of the "noise" text.
The viewer supports sending multiple queries to the server.
The "results list" supports multiple selection, so you can easily copy sections of the results to the 

Windows clipboard.

Telnet/3270

The paths to the telnet and 3270 executables are configurable. WSGopher supports a flexible 
command line, where host and port parameters are inserted in the proper place on demand.

WSGopher pops up an information window containing the host name, port, and any advice given 
by the Gopher server (such as login ID).

WSGopher launches the telnet application and passes hostname and port on the command line. 
If the telnet application does not understand this (as some don't), then the user can 'copy' the hostname 
from WSGopher's telnet info window to the Windows Clipboard, then paste it into the appropriate place in 
the telnet application. 

WSGopher supports "extended views" where a Gopher+ server can advise the client which type 
of emulation to use; this could support more than just telnet and 3270.

Printing

In the Page Setup dialog, the user can select margin widths for top, bottom, left and right, and 
specify whether or not to print headers and/or footers.

Since the standard Print Setup is supported and used, WSGopher can print portraint or 
landscape, and supports any other options specified in Print Setup.

Supports Print Preview for all document types that can be printed
Printing uses selectable printer font, or font used by window you are printing from.



New Gopher

The New Gopher dialog allows the user to fetch a Gopher item not currently in a directory menu.
If the New Gopher dialog detects that the Windows Clipboard contains data which could be a 

bookmark (using the 'standard' notation generated by the Unix client and others), then this information 
can be pasted directly into the dialog with a single button click. The bookmark data can be surrounded by 
other text, and does not need to be at the left margin. Note that the dialog recognizes standard item type 
codes and displays the right selection in the item type droplist.

The New Gopher dialog supports URLs; you can paste a URL into the window, and the dialog will 
automatically convert it to a "normal" bookmark.

Bookmarks

The bookmark for any active document can be saved by an entry in the Bookmarks menu, or 
(preferred) the 
  button in the Toolbar. Directories can also save bookmarks for any item in the menu.

Duplicate bookmarks and bookmarks with ridiculously long paths (like those sometimes 
generated by index searches) are supported. In the first case, this makes it easy to clone a bookmark.

Bookmarks can be added, deleted and modified. One helpful feature is that item type can be 
easily corrected. This is often used when a Gopher server incorrectly advertises a file as text, when it is 
really a DOS archive or PostScript file, for instance. The bookmark for the item can be saved, the item 
type corrected in the Bookmark Editor, and then the item is fetched from within the Bookmark Editor. 

You can save and fetch bookmarks for Ask forms.
Bookmarks can be copied to the Windows clipboard in 'standard' Unix client format.

Miscellaneous

The 'redundant home server' is supported, and the initial menu title. Check the Configure menu, 
Home Gopher item.

WSGopher looks for its INI file in the directory where the executable is installed; then in the 
current directory; finally in the Windows directory (wherever that is on your system). If not found, it is 
created in the directory where the executable is installed.

WSGopher tries to use a reasonable size for the main window.
When you exit WSGopher, it 'remembers' its size and position on the screen, and whether it was 

minimized, maximized or normal size. It then uses these settings when you next start up.

_________________
See also
Introduction to WSGopher



What's new in WSGopher 1.1

New in WSGopher 1.1

Addition of Cancel andCancel All buttons/menu options.    These buttons cancel network activity 
for the current window or all windows, respectively.    You will be asked whether you want to save any data 
you have already accumulated.

Home Gopher is now more robust.    First, if you have twoHome Gopher servers configured, 
WSGopher (again) picks one at random.    This was broken in version 1.0 but worked before that.

Second, if one Home Gopher fails, and you have two configured, WSGopher will automatically try the 
"other one".    If both Home Gophers fail, then you will be presented with a dialog box explaining what 
happened, and then the Home Gopher setup.

Several individuals pointed these problems out, including Rob Peterson and Andy Berkvam.

The network layer is more robust.    For one thing, if you cannot create a socket, you will get a 
more reasonable error message unless you are indeed out of resources.    (A "socket" is the piece that 
clients and servers talk to each other through; if you can't make one, then you are really going nowhere.) 
Thanks to Stephen Trier for pointing this out. 

In general, error reporting is improved.

Longer ask forms should work better.

Text documents should download and display more quickly; the display is also improved.    
Sometimes there was a "ghost line" at the bottom.    I am hoping that some lines that weren't displayed 
will now be.    Mark Johnson and Ashok Aiyar found this.

The temp files that WSGopher used to create for large text documents are no longer used.    I have 
tested the new logic with files up to 32,305 lines, about 1.8 MB; the download seemed to have a 
consistent speed throughout. Thanks to Mark Edwards and Kyle Parrish for helping me to find largish 
files. 

When you are selecting text in the text window, the line containing the selected text no longer 
goes up and to the left one pixel.

The text window scrollbar now works like you would expect; operations that go to the bottom now 
position the scrollbar at the bottom, etc. Thanks to the countless people who mentioned this :-)

The results of phone searches now can be quite long, on the order of 8K lines if needed.    I have 
been unable to find a phone search that returned more than 700 entries, or roughly 4K lines.

When you fetch something from the Bookmark Editor, the editor can either stay up (as it has in 
the past), or will be minimized or close automatically.    See the Options dialog to control this behavior.    
Many, many people suggested this to me.

The Information window now has buttons for copying, closing and help. The way copying works is 
this:    if you have any text selected in the window, then that text is copied.    Otherwise, all the text in the 
window is copied.

The phone book no longer auto-selects the "name" field.    This is more appropriate for the newer 
CSO servers, which either don't have a default field or have one other than "name".    There is no means 
by which a CSO client, such as WSGopher, can determine which field is default.    Thanks to Steve Fram 
and Peter Wood for their correspondence.



I believe I have worked around the "empty directory" problem.    All the empty directories I have 
found since that time have indeed been empty.    You should now be able to safely use 
"application/gopher+-menu" at the top of your Preferred Views list, like I do :-)

If you select an ask form, and for some reason the form does not have any ask data, it will 
attempt to get it from the Gopher server.    If it fails the form will be closed, after an explanatory message. 
Otherwise, it's business as usual.

Copying exceptionally large amounts of data to the clipboard now works.    For instance, you can 
now copy "All the Gopher Servers in the World".    Various folks have pointed this out to me, but it was 
really hard to track down because you had to copy (it turns out) more than a `segment' worth; who made 
up this segmentation stuff, anyway?

WSGopher now is much more proactive in detecting the end of the data stream without waiting 
for WinSock to send a network event to that effect.    This means that many Gopher+ images should be 
viewed immediately when they are 100% complete; also directories, text files and extended bookmark 
information should be complete much more quickly. This should be most helpful to users of Trumpet 1 
beta 10 and beyond. 

This still won't help some Gopher+ downloads, or any Gopher0 binary downloads.    If the server 
doesn't tell WSGopher exactly how large the item is, or if it's not delimited the way a directory or text 
file should be, then WSGopher has now way of knowing. 

Added a Fetch command to the Bookmark menu; this displays a dialog that contains two scrolling 
lists, one for the current categories (assuming you have any) and one for the bookmarks in the category 
you select (first shows "default category" if you have one).    Select a category, then select a bookmark.    
To fetch, either double click the bookmark or click the OK button.    It's a lot faster than using the 
Bookmark Editor.    This dialog is resizable; the title list gets wider but the category list stays the same.    
It's a feature, not a bug :-)

If you fetch an item in a directory, and along the way you select a view for this item, WSGopher 
now "cleans up" the item so that when you next fetch it you can select a view without being forced to use 
the same view as before.

Implemented Paul Lindner's advice with respect to extended views and language tags.    Thanks, 
Paul!

Implemented a reload feature; for directory, text and phone windows, you can use File/Reload or 
the F5 key to refresh the contents of the window.    This only works when the transfer is complete.

Fixed a long standing bug where, if for some reason you were downloading a binary file into a 
text window, the window no longer crashes just because it can't reasonably handle lines more than 32K 
bytes long.    Just the same, you might still not see anything in the text window.    The moral of the story is 
not to download binary files into a text window!    If you do this, try File/Fetch Item As to use the same 
bookmark with the Image type. 

Implemented an intelligent back track.    Any window that was created via another window, that is 
something selected from a directory, or the directory that results from a search, is capable of restoring its 
parent if that parent still exists.    See the arrow that points up and left in the Toolbar, or Window/Back 
track.    I have lost count of the number of people who asked me for something like this; Andy Berkvam 
was one of the more recent folks who I discussed it with.    Thanks to everyone who brought it up, no 
exceptions.

Along the same lines, when you fetch a bookmark, WSGopher now tries to determine if you 
already have a window for that bookmark; if so WSGopher restores the window rather than fetching 



again.    Note that in many cases you can "reload" if needed.

Ask forms are the exception; you may have more than one instance of an ask form.

Added a setting to the Options dialog to accomodate users who do not wish to use WSGopher as 
a multi windowed application; some folks are just more comfortable with the single window approach, 
apparently. Anyway, the setting is kept across sessions and enforced during the session.

Alert user Robert Fabian discovered that if you use certain defective free True Type fonts with 
WSGopher, that it can crash with a "divide by zero" error ... WSGopher now protects itself from such 
bogus fonts.

Michael Haseltine (and probably others) pointed out that, when you are saving a text window to 
disk, WSGopher doesn't check to see if the file already exists.    It does now. 

Added a new menu entry and Toolbar button for saving the bookmark for a directory.    It is only 
available when the current window is a directory.

Fixed a bug in the ask form that would cause one or more Note's at the end of a form to not be 
displayed.    Gail Bird, our project Gopher admin, found this.    Thanks, Gail!    Also added page up, page 
down, home and end to form windows; I wish I could figure out how to add tabs and back tabs so it would 
act like a real dialog.

Thanks to Robert Fabian, I found and fixed a bug where occasionally a text file would think it is 
"finished" only partway through.

You can now pass a Gopher URL on the command line; this will override the Home Gopher 
server.    Scott Barker of UNC provided the impetus.

If you try to print or preview and the file is not completely downloaded, you will now get a dialog 
box to the effect that you can print, but it will be incomplete.    Milton Turner suggested this.

You can now specify a selector with your Home Gopher server(s).    Mark Johnson prompted me 
on this one.

The information window is now resizable.

You can now specify an alternate directory for configuration files, including WSGopher.INI.    
There are two methods, the environment variable WSG_CONFIG and the command line argument -I 
followed by the directory name.    The command line argument takes precedence.

Let's say your configuration files, including the INI, the CNF files and the help file are stored in F:\gopher. 
You could call WSGopher like so:

        wsgopher.exe -IF:\gopher

or you could set the environment variable like so:

        set WSG_CONFIG F:\gopher

Many thanks to Alex Reijnierse for his patience in helping me work through this, and to Carl Karcher.

Fixed problems with ask blocks with no associated views; this is pretty unusual ... but hopefully 
now WSGopher will work with the Stanford Portfolio system.

Text search within WSGopher now supports the Boolean operators AND, OR, NOT and ADJ.    



These are simple Boolean searches, no paranthenes, and only two arguments.    For instance you can 
search for 

        Dave OR David

but not (Dave OR David) AND Brooks

The operator separates the operands; for instance 

        Dave Brooks AND WSGopher

matches material containing both the strings "Dave Brooks" and "WSGopher".    Blanks count, except 
between the operator and the operands. 

The search is still line oriented.    When a match is found in a text window, the operands are selected as 
well as the material inbetween.    As before, search is supported in directories, text windows and phone 
search results. 

A text string without one of the Boolean operators is used in a plain search, as before.

Carla Cavianai, the TIS training coordinator, gets the credit for this idea.    I think it is way cool.

_________________
See also
Introduction to WSGopher



Upload a file in an Ask form

One item supported by the Ask form is the ability to upload a file from your computer to the Gopher 
server. You must be very careful not to send confidential or proprietary information, unless you are 
absolutely sure that it is going to the right place!

Use the File dialog box to choose a file on your computer. You will notice that the file already must exist. 
Also, the Ask form does not give you the opportunity to edit the file path by hand. However, you can use 
the Browse button and select a different file as often as you need to.

Be sure to check the discussion on Text vs. Binary in the Overview topic.

_________________
See also
Overview of the Ask form



The Fetch Bookmark Menu

The Fetch Bookmark menu is a faster alternative to the Bookmark Editor, if all you want to do is fetch a 
bookmark.

Select Fetch from the Bookmark menu, or click  which is now the leftmost button in the Toolbar.    You 
get a resizable dialog box with several scrolling lists; the list on the left contains your category names, 
and the list on the right contains the titles of the bookmarks in that list.

As you select a category, the bookmark titles for that category will fill in the list on the right.    You can 
double click on a bookmark title to fetch the bookmark; that will close the window.    Clicking on a 
bookmark title, followed by the OK button or the ENTER key, will also do the job.

The Fetch Bookmark menu now supports the keyboard; type a single character to go to the 'next' item 
that starts with that character.

_________________
See also
The Category Window
Setting a Default Category
Overview of Bookmarks
Fetching Bookmarks



Backtrack

Starting with WSGopher 1.1, Gopher windows now know the URL of the window that launched it, that is 
it's parent window. If you fetch an item from a directory, then the directory window is the items parent 
window.    If you use a search window to form a query, the result is a directory; in this case the search 
window is the parent of the directory window.

When the active window has a parent window, then you will be able to select Fetch from the Window 
menu, or use the     Toolbar button.

Note that items fetched from the Fetch Bookmark menu, the Bookmark Editor, the New Gopher dialog or 
the Fetch Item As dialog do not have parents.    Also, the Home Gopher window does not have a parent. 

_________________
See also
Fetch Bookmark menu
Bookmark Editor
New Gopher
Fetch Item As
Home Gopher



Adding Directory Bookmarks

In response to a demand to make it easier to add the bookmark for a directory, as opposed to the 
selected item in the directory, I've made it possible to do so in one step.

Starting with WSGopher 1.1, you can select Add Directory Bookmark from the Bookmark menu or click 
the     Toolbar button.    The steps after this are the same as for adding the bookmark for an item, except 
that the directory bookmark is added instead.

_________________
See also
Adding a bookmark



Cancel the Current Transaction

Starting with WSGopher 1.1, you can now safely cancel network activity in progress for the active window, 
and for all windows, without losing the data you have already collected.

To cancel the current transaction, select Cancel from the File menu, or click the  Toolbar button. You will 
see a dialog telling you how many bytes you have downloaded, and asking whether to close the window 
or keep the (possibly) incomplete data.

The reason I call the network activity a transaction is because ... well, I just do.

_________________
See also
Fetching Bookmarks



Cancel All Transactions

Starting with WSGopher 1.1, you can now safely cancel network activity in progress for all windows 
without losing the data you have already collected.

To cancel the current transaction, select Cancel All from the File menu, or click the  Toolbar button. You 
will see a dialog telling you how many bytes you have downloaded, and asking whether to close the 
window or keep the (possibly) incomplete data.

The reason I call the network activity a transaction is because it is like a transaction you might do at the 
store or bank.    You send some bytes to the Gopher server, it sends some bytes in return, and then you 
close the connection.    For the next transaction, you start again.

_________________
See also
Fetching Bookmarks



Reload

Starting in WSGopher 1.1 you can reload a directory, text window or phone book. The window empties 
itself, reconnects to the same Gopher server, asks for the same item, and downloads it again.

Right now, this should be most useful to Gopher server admins who are constructing menu hierarchies, 
editing files, etc.    It will also be useful to users who have the ability to update their own Gopher 
hierarchies; I hope that increases as time goes on.

_________________
See also
Fetching Bookmarks



What is changed in WSGopher 1.2

Worked on problems with Ask blocks, including:
1. You can now follow Ask blocks across links; on a related note, the Send button no longer appears 

until the ask block is built.
2. I think I have fixed problems with gshield, at least I have for David Drum of MORENet.
3. You can bookmark ask blocks, and fetch items as ask blocks.    The dialogs New Gopher Item, Fetch 

Item As, and the Bookmark Editor all have Ask block fields in addition to the Gopher+ field.
4. When you have an ask block with a Choose File field, that is, one that prompts you for a local file, 

WSGopher now reads the file (well, the first part of it, anyway) to determine if it is text or binary.    The 
method of uploading a binary file is different from uploading a text file, and it is not widely supported in 
Gopher servers prior to version 2.1.

5. With help from Gerrit Thomas, binary transfers are now much more likely to work!

Fixed a bug that caused upload of large files to not work on some WinSock stacks. Thanks again 
to Bob Quinn and Vikas Garg for their help!

Fixed cleanup bug which prevented you from using the same phonebook twice in one session.    
Thanks to Kay Johnson and Steve Fram for reporting this.

Ports are now unsigned integers, like the WinSock spec calls for; this only affected sites using 
ports over 32767.

Case sensitive searches within a Gopher window, where at least part of the search string was 
upper case, now work; thanks to Stephen Trier for reporting it and providing a test case.

Even though I thought it was working, when you saved a text file, the file dialog was not checking 
to see if the file already existed and prompting you if so.    This works, even though I advertised it as 
working earlier.    Thanks to the several individuals who pointed it out.

Some text files had a trailing period; this is now eliminated.

The Fetch Bookmark dialog now supports the keyboard, in that you can type a single character in 
either of the lists (category or bookmarks) and find the 'next' item starting with that character.

Fixed a bug reported by John Morphet that caused WSGopher to GPF when copying very large 
amounts of data to the clipboard.    A note on this: during testing I found that some products did not paste 
large clipboard data well, including Wnot and the new Clipbook.    I have also heard but not confirmed that 
Word 2.0 may actually GPF when pasting text data.    On the other hand, Word for Windows 6.0 was able 
to paste the entire text of a fairly long document.    Your mileage may vary.

Jim Minatel of Que just phoned me (don't try this at home!); as a result, I have changed the key 
that invokes the Info window from '=' to CTRL+I. Advanced queries, like options for Veronica and Jughead, 
should now work correctly. This is probably the last time I'll try to support keys from the Unix client :-)

Many of the following were found by friends in the San Jose area; thanks to Oliver, Jack and other fine 
folks:

I believe I have found and fixed a GPF that is very hard to reproduce, but apparently has to do 
with the way WSGopher registers windows by URL, and what happens when a Home Gopher server fails.

Along with that, if your second attempt at a Home Gopher succeeds, windows launched from that 
directory now have a parent they can backtrack to.

The Home Gopher setup dialog now handles zero ports better.



When WSGopher is exiting, it now cancels any outstanding requests to resolve hostnames.    This 
will probably affect you most if you are using a dialup line.

You can no longer rename a category to an existing category; also, if you delete the default 
category, the "default category setting" is now set to "no category".

Attempted to resolve problems seen occasionally when you use a keystroke in an empty directory 
window; the error is "Directory has invalid selection", and sometimes that directory would never get filled.

If a text window has a horizontal scrollbar, and you scroll right, and then resize the window so that 
the horizontal scrollbar disappears, the text would remain scrolled.

It was possible to GPF in the Bookmark Editor if you had a category with only one bookmark, you 
select it, and then change the text in the dialog without selecting the bookmark again, and then click the 
Delete button.    I also found several other similar problems and fixed them.

The Always Maximize Windows setting was not taking effect with the Home Gopher window; 
windows after that would be maximized.

The Print and Copy toolbar buttons are now in sync with the windows that support those 
operations.

WSGopher now has the non-standard behavior that TurboGopher and the Unix text gopher client 
have, when it comes to interpreting Gopher+ error messages, particularly from gshield.    These 
messages lack the error code token, and I was displaying them as an unknown error type.

When you scroll right in a text window, and select text, the right text is now selected.    Thanks to 
Ken Blackney for reminding me about this.

There is now a shortcut in the Category dialog; if you type a name into the Name field, and the 
name is not assigned to a category, then when you click on the OK button the dialog asks you if you wish 
to create that category, and if so, then that category is both created and used for your selection.

Chris Halverson noticed a grammar mistake.

Note: several people reported that the Info window no longer behaves like they expect; if they have 
selected an item in a directory, then bring up the Info window, the information shown is for the directory, 
not the item.    However, this is not a bug, it's a feature! The Info topic explains this.

_________________
See also
WSGopher Features
What s new in version 1.1



Why an alternative hypertext document?

or, 'Toward a Component Architecture'

or, What's wrong with HTML?

The answer is that nothing is wrong with HTML; it does what it was designed to do, which is enhance text, 
provide hypertext links and inline graphics.    Its popularity could be owed to the fact that it succeeds at 
those jobs.

However, there are a number of things HTML was not designed to do.    These come to mind:

1. HTML doesn't provide an interface to every known protocol.    I use Web browsers for looking at Web 
pages; it's nice that I can do FTP with them also, but they are not very good FTP clients, and they are 
particularly bad Gopher clients; furthermore, I can't do WAIS with most of them.

2. HTML doesn't meet many publishing requirements. True, Netscape has some nice extensions to 
HTML, and progress with HTML 2.0 and beyond continues; and SGML someday may be merged into 
HTML, at least a good part of it.    But, HTML doesn't currently provide equation handling, tables, or 
real layout control, and it is not clear that advanced HTML browsers will be widely available any time 
soon.

On the other hand, publishing mechanisms are becoming available which do give you hypertext and 
advanced layout capabilities.

The University of Minnesota Gopher Mongoose team has announced a product called InternetLink which 
gives you the capability of placing link in an Adobe Acrobat document. The link information is in URL 
format, the standard format used in HTML. When the user reads the document and clicks on the 
hypertext link, InternetLink passes the URL to a program on that users machine that handles it, whether it 
is Gopher, FTP, Web, WAIS, whatever.

For more information on InternetLink please contact the Gopher team at 
gopher@boombox.micro.umn.edu.

I'd like to follow with a quote from Mark McCahill of the University of Minnesota:

[...] Given standard URLs, there is a good way for one application to signal another and tell it 
what to fetch; an application can ask another to get an item pointed at by a URL. Once one 
application can call another and tell it what to fetch, several things happen to the client 
architecture for internet applications.

First, there is no particular reason to write monolithic applications that claim to do it all. Instead, 
you can assemble a suite of components (each of which do one thing well) which work together 
collectively to give you all the functions of the baroque, chrome-lined, gas guzzlers. This 
component architecture gives the user choice about which gopher, or ftp, or http module they use. 
It also allows the people writing the network applications to concentrate on doing one thing really 
well instead of doing all things in a mediocre fashion. This also helps make the individual modules 
much more maintainable since they are smaller and simpler. You can see this trend in the new 
release of TurboGopher in that it no longer incorporates the CSO/Ph functionality inside 
TurboGopher. Instead it calls a helper application when it is time to handle CSO/Ph phone books. 
The people who live and breath CSO/Ph are probably the ones who will do the best job of writing 
a CSO/Ph client.

The second thing that standard URLs do to client architectures is makes it easy to do is to add 
internet-aware hypertext-like capabilities to a variety of applications/page description languages. 
If my e-mail program can call Turbogopher with a GetURL event to resolve gopher URLs, then e-



mail feels like hypertext. This is what the new version of our POPmail e-mail client does. The 
same thing can be done with a page description language (and this is what our InternetLink 
plugin for Acrobat PDF files does). With standard URLs and clients that understand a GetURL 
message, it's straightforward to make most page description languages internet-aware, so one 
consiquence of this is that all sorts of document types will have URLs embedded in them. There 
will be a proliferation of internet-aware page description languages over the next year.

So... client software starts working in two modes. You either run it as a standalone application to 
browse and search or another application calls it to resolve a URL. When we have internet-aware 
spreadsheets, word processors, mathematics packages and CAD/CAM packages, it isn't going to 
be because the every program turns into a 40 mbyte monster program with built-in support for 
gopher, ftp, nntp, z39.50, wais, http, etc. Instead, it will be because there is a standard way for 
one program to call a gopher or ftp or other client to resolve a URL.

What you are seeing in the new Turbogopher is just a logical extension of the helper application 
concept that started with calling an external telnet program in the early days of gopher, and then 
was extended to calling helper applications to render images, movies, and other complex 
documents when the Gopher+ clients were released. Now we (and others) are calling external 
applications to fetch items off the network... but this is really just more of the same strategy. You 
see the same thing in Gopher Surfer in that it can uses an external search engine (AppleSearch) 
to extend its functionality to include full-text searches. 

So the big picture is that we are committed to component architectures because this makes it 
easier to write network applications, gives the users more choice in the tools they use, lets us 
take advantage of standardized network resource pointers (URLs), and is the shortest path to 
making all sorts of applications internet-aware. 

Mark P. McCahill gopherspace engineer
mpm@boombox.micro.umn.edu University of Minnesota
612 625 1300 612 625 6817 (fax)

Disclaimer:    I do not represent the University of Minnesota, and I do not wish to commit the Idaho 
National Engineering Laboratory in any way.    I present the information above only for the user's 
education.    Comments are welcome.




